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Notice: 
 
 Signal Communications Limited reserves the right to make improvements to the 
product described in this manual at any time and without notice. 
 
 This manual is copyrighted. All rights are reserved. This manual should not be 
copied, reproduced or translated in whole or part without prior consent from Signal 
Communications Limited. 
 
TeleEye is a trademark of Signal Communications Limited and is registered in China, 
European Communities, Hong Kong, US and other countries.   
 
All other trademarks are the property of their respective owners. 
 
 
 
Copyright (c) 2016 Signal Communications Limited (A member of TeleEye Group). 
All rights reserved. 
 
Version 1.27.0 
 
 
 
 
Limits of Liability and Disclaimer of Warranty 
 
 Signal Communications Limited has taken care in preparation of this manual, but 
makes no expressed or implied warranty of any kind and assume no responsibility for 
errors or omissions. No liability is assumed for incidental or consequential damages 
in connection with or arising out of the use of the information or accessories 
contained herein. 
 
Features and specifications are subject to change without prior notice. 
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1. Introduction 

 

1.1. Features of sureSIGHT Lite/Business 

sureSIGHT is an integrated video management platform for IP cameras and Video 
Recording Servers. Its modular design allows customers to scale up easily and add 
functional modules to suit specific requirements. 
 
� Up to 64 HD live video from TeleEye MX Series 
� Manage multi-site and cameras simultaneously 
� Comprehensive event log 
� Modular design & operation 
� Operator account management system 
� Support TeleEye GX, MX, NX, RX, CX, JN, VN, MP, MQ Series 
� siteMAP function support user to monitor an area systematically 
� Optional ONVIF, sitePOS, siteMAP, siteCHECK, Video Analytics modules 
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1.2. System requirement 

 Lite Business Lite/Business with 

Analytic function 

Processor Intel® Core™ i3 Intel® Core™ i5 

Memory 4GB 

Hard disk 50GB free space 

Display Direct 3D supported. 

E.g Nvidia® GeForce™ GT620 

E.g ATI® Radeon™ HD 6450 

Operating 

system 

MS® Windows XP Home/Professional SP3 

MS® Windows 7 

MS® Windows 8/8.1 

MS® Windows 10 

MS® Windows 7 

MS® Windows 8/8.1 

MS® Windows 10 

 

 

1.3. Manual convention 

[ButtonName] Button Name 

{Window/Panel} Window/Function Panel 

-> Sublevel of the controlling 

Component Part Component Defined in working 
environment 

“function” Function in the system 

***Remark Remark for the process 

“Parameter” Parameter for user input, e.g. Username, 
Password 
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2. Installation and Un-installation 

 

2.1. Before installation 

In Windows Vista or later administrator permission is required for installation. If the 
current user does not have administrator privilege, a {User Account Control} dialog 
will pop up asking for administrator account and password. 
 
Request for Administrator Privilege 
Please select an administrator account and type the password to continue the 
installation. 
 
If “User Account Control” in Windows 7 is enabled, Windows may ask for the 
permission to install the program. Click [Allow] to continue. 
 
User Account Control 
 
If .NET framework 2.0 is not installed, the installation process will start automatically. 
 
Permission may be required to install Microsoft SQL Server. Click [Continue] to 
continue. 
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2.2. Installation 

To start the installation, you can simply follow the autorun of the disc or click the 
installer file directly. 
 
***Installation of sureSIGHT Lite and sureSIGHT Business are the same, but cannot 
be installed on a same computer. 
***If there is a previous version of sureSIGHT in the computer, please un-install it first, 
please refer to chapter 2.3. 
 

 
 

You need to install the sureSIGHT Lite/Business, Java Runtime. 
 
Step 1. Click [Install] of sureSIGHT Lite/Business. 
 
If Visual C++ 2005 Redistributable is not installed, an installation window will be 
shown. 
 
Step 2. Click [Yes] to install Visual C++ 2005 Redistributable. 

 
Step 3. After Visual C++ 2005 Redistributable is installed, you can start install 

sureSIGHT. 
 
Step 4. [Browse] the installation path for sureSIGHT, [Disk Cost…] is available for 

you to check the available space for installation, then click [Next>]. 
***The default path C:\Program Files\TeleEye\TeleEye sureSIGHT\ is 
recommended. 

 
Step 5. Click [Next >] to confirm the installation. 
 
Step 6. Click [Close] when the installation completed. 

 
Step 7. Install Java Runtime Environment (if required). 
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2.3. Uninstallation 

***Uninstall of sureSIGHT Lite and sureSIGHT Business are the same. 
 
You can uninstall sureSIGHT from control panel 
 

 
 
Also, they can click [Uninstall sureSIGHT] in the Start menu.  
 
After they click uninstall, a confirmation windows of {Windows Installer} appears. 

 
Click [Yes] in the confirmation windows, the uninstall runs automatically. 
 
 

3. License  

 

3.1. Register sureSIGHT Business  

You have 30 days trial to use sureSIGHT Lite/Business. To continue use the software, 
you have to register the software license. 
 
Step 1. Click [System] -> [License] to show the license status window. 

 
Step 2. To register sureSIGHT Lite/Business, click [Click to register sureSIGHT 

Business]. 
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Step 3. Choose a registration method 

 

 
 
Online registration is a more convenient way for you to register a license. For 
the online registration, please make sure that this computer is allowed to access 
to the Internet. 
 
Offline registration does not require the Internet accessibility. You need to 
follow from the steps 6 below to complete the registration. 
 

Step 4. {Online registration} For online registration, you are required to login 
before doing the registration. Once you have logged in. System will not ask you 
to log in again.  
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If new customer who does not have an account, he needs to sign up a new 
account by clicking [sign up a new account] before registration. 
 

 
 
Fill in the information and click [Register] to register a new account. If register 
success, it will go to the registration page. 
 

Step 5. {Online registration} Enter the serial number and click [Register] to 
process the registration. 
 

 
 

Step 6. {Online registration} The license page will be updated. 
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Step 7. {Offline registration} To register a license, you can type in the software 
serial number and click [Apply serial no] button to generate an “Authorization 
Code”. With the software serial number and authorization code, you can register 
the license online. 
 

 
 

Step 8. {Offline registration} Click hyperlink http://www.TeleEye.com and go to 
TeleEye homepage. Find [Customer Login] button at the bottom of the 
homepage and click to enter the customer login form. 
 

 
 
Step 9. {Offline registration}Go to the bottom of the web page. For registered user, 

type in login ID and password to login to the system. New user need to sign up 
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first. Click “Sign up here!” to enter sign up form. 
 

 
 
Step 10. {Offline registration}Enter your personal information and click [Register] 

button. Now, you may use the login ID and password to log in to the system. 
 

 
 
Step 11. {Offline registration}Find “Software Registration” under “TeleEye Support”. 

 
Step 12. {Offline registration}Find “TeleEye sureSIGHT Lite/Business/Pro” under 

“Software Registration”. 
 

 
 
Step 13. {Offline registration}Type in the software serial number and authorization 

code and click [Register] to generate a registration code. 
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Step 14. {Offline registration}Type the registration code into the {Software 

registration form} and click [Register] 
 

Step 15. {Offline registration} The license page will be updated. 
 

 
 
 

3.2. Register siteMAP 

***Similar to Register sureSIGHT Lite/Business, reference to (3.1 Register 
sureSIGHT Lite/Business) 
 
siteMAP is a function to manage numerous sites, position cameras and verify alarms 
through multi-layer siteMAP, floor plan and reference images. 
 
You need to register the siteMAP license online before they can use it. 
 
Step 1. Click [System] -> [License] to show the license status window. 

 
Step 2. Click [Click to register siteMAP function]. 

 

 
 
Step 3. {Online registration}, please follow step 2 to step 5 of online registration of 

Register sureSIGHT Business (Chapter 3.1). 
 

Step 4. {Offline registration}, please follow Step 6 to Step 10 of offline registration 
of Register sureSIGHT Business (Chapter 3.1). 
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3.3. Register siteCHECK License 

 
***Similar to Register sureSIGHT Lite/Business, reference to (3.1 Register 
sureSIGHT Lite/Business) 

 
Step 1. To register siteCHECK license, click [Click to register siteCHECK 

function]. 
 

 
 
Step 2. {Online registration}, please follow step 2 to step 5 of online registration of 

Register sureSIGHT Lite/Business (Chapter 3.1). 
 

Step 3. {Offline registration}, please follow Step 6 to Step 10 of offline registration 
of Register sureSIGHT Lite/Business (Chapter 3.1). 
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3.4. Register Other Site License 

 
***Similar to Register sureSIGHT Lite/Business, reference to (3.1 Register 
sureSIGHT Lite/Business) 
 
***One other site license allow you to add 4 sites to the sureSIGHT. 
 
Step 1. To register other site license, click [Click to add other site license]. 

 

 
 

Step 2. Select [Register license] and click [Ok] 
 

 
 

Step 3. {Online registration}, please follow step 2 to step 5 of online registration of 
Register sureSIGHT Lite /Business (Chapter 3.1). 
 

Step 4. {Offline registration}, please follow Step 6 to Step 10 of offline registration 
of Register sureSIGHT Lite/Business (Chapter 3.1). 

 
Step 5. The other site license is added. To add more other site license please repeat 

Step 1 to 4.  
 

 
 

3.5. Register Flow Analysis license 

 
Step 1. To register Flow Analysis license, choose “Video Analytic 1” tab and click 

[Add demo code], [Add 1 cam license] or [Add 4 cams license]. 
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Step 2. Input Serial number and click [Apply serial no] button to generate an 

“Authorization Code”.  
 
Step 3. {Online registration}, It is similar to step 2 to step 5 of online registration of 

Register sureSIGHT Business/Lite (Chapter 3.1). 
 
Step 4. {Offline registration}, it is similar to Step 6 to Step 10 of offline registration 

of Register sureSIGHT Business/Lite (Chapter 3.1). 
 

Step 5. Input Registration code and Analytics registration code. Then click 
[Register]. 

 
Step 6. The registration is finished. 
 
 

3.6. Register intrusion detection, loitering detection, 

and unattended/missing object detection 

 

Similar as registration of Flow analysis, each of the intrusion detection, loitering 
detection, unattended/missing object detection have three license types available, 
and are registered separately. 
 
Three license types are available. 

- Demo: Trial for 1 camera for 30 days. 
- 1 cam license: Support 1 camera for each license. 
- 4 cams license: Support 4 cameras for each license. 

 

Remark: 

- The three analytic detections can be registered and applied on the same camera. 

- However, Flow Analysis can only be used exclusively. 

- Maximum of 16 camera, including Flow Analysis, can be enabled on a single 
sureSIGHT. 

-  

To register intrusion, loitering and unattended/missing object detection, it is similar to 
registering Flow Analysis. Please follow section 3.5, and choose the correct license 
type accordingly.
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Re-install software in a new PC  

To re-install the software in a new PC and keep the existing value-added modules, 
you should un-register the license and re-register it on the new PC. You can follow the 
step below: 
 
Step 1. In {License management} windows, click [Unregister] 
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Step 2. A text file is shown, please backup the text file and the code on it. 
 

 
 
Step 3. Repeat step 1-2 if another function/upgrade need to do. 

 

 
 
Step 4. After installation in new PC, in {License} window, select [Click to register 

sureSIGHT Business/Lite] 
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Step 5. Select [online registration] and tick the [Reregister license]. Click [Next] 
to do the online re-registration. You can also choose [offline registration] and 
flow from step 8. 
 

 
 

Step 6. {Online registration} Enter serial number and un-registration code. Click 
[Register] to process the re-registration. 
 

 
 

Step 7. {Online registration} Success message will be shown when re-registration 
completed. 
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Step 8. {Offline registration} Enter the Serial number in the {License} window, 
then click [Apply serial no.], get the New Authorization Code. 
 

 
 
 
Step 9. {Offline registration} Visit http://www.TeleEye.com. Find [Customer Login] 

button at the bottom of the homepage and click to enter the customer login form. 
 

Step 10. {Offline registration} At the bottom, choose “Software Re-registration”, 
click [here] 
 

 
 
Step 11. {Offline registration} Enter the Software Serial No, Un-registration Code 

and New Authorization Code. 
*** The New Authorization Code generate from Step 5 
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4. sureSIGHT Working Environment  

 

4.1. Login  

For new installed sureSIGHT, the default user account support is disabled, so no login 
is required. To enable user account support please refer to Chapter 6.1. 
 
If user account support is enabled, a login page is shown after starting up of 
sureSIGHT. To login sureSIGHT, input “Username” and “Password” to login to the 
system.  
 
(Remark: The default password for the “administrator” is “000000”) 
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4.2. Main panel  

 
 
In {Main} window,  
Panel Name Description 

1 Main menu The main panel to navigate most of the important function 

2 Main toolbar Show the most commonly used functions for quick action. 

3 Expandable 
panel 

Expandable panel include Connection profiles, Audio and 
Switch panel  

4 Live View 
panel 

Area to display the video 
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4.3. Expandable panel 

Connection profile list: 

 
 

In {Site list} and {Connection profile list} window,  
Panel Name Description 

1 Connection 
profile list 

List of connection profiles and groups 

-  ***The windows always on top when [Always on top] 
box clicked. 

Audio panel 

 
 
In {Audio} window,  
Panel Name Description 

1 Audio enable To enable/disable audio of a site 

2 Audio 
Reception 

You can select the audio channel, and control the 
speaker volume through enabling the speaker function 

3 P.A & 
Pre-recording 
panel 

You can send a remote vocal to the site 

-  ***The windows always on top when [Always on top] 
box clicked. 
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Switch panel 

 
 
In {Switch} window,  
Panel Name Description 

1 Switch panel It act as a graphical interface of the switch in remote sites 

-  ***The windows always on top when [Always on top] 
box clicked. 

 

Event panel 
 
In {Event} panel, 

 
Different icons represent different events of the site connected 
 
Global event status 
 
Icon Meaning 

 

Global system tamper event. Flash when event triggering. 

 

Global Alarm event. Flash when event triggering. 

 

Global motion event. Flash when event triggering. 

 

Global video loss event. Flash when event triggering. 
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Global harddisk event. Flash when event triggering. 

 

Global power failure event. Flash when event triggering. 

 

Global over heat event. Flash when event triggering. 

 

Guard management event has been tampered 

 

PC CPU Usage. Flash when usage higher than 80%. 

 

PC memory usage. Flash when usage higher than 200MB. 

 
siteMATRIX lost event. Flash when siteMATRIX disconnected IS 
abnormally. 

 
Event is triggered in one or more siteMATRIXs. Flash when event 
triggering.   

 

sureREC event. Flash when event triggering 

 

siteCHECK event. Flash when event triggering 

 

Video analytic event. (Flow Analysis, intrusion detection, loitering 
detection, unattended/missing object event) 
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Connection panel  
 
In {Connection info} panel, 
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4.4. sureSIGHT system settings 

4.4.1. Working environment  

 
 
To open the System settings window, you should select [System] -> [System 
settings…] from {Main menu}.  

 
 
In {System settings} window,  
Panel Name Description 

1 Category 
panel 

General settings/Video settings 
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2 System 
settings 
panel 

List of general setting user can change 

3 Confirmation Setting will not take effect before the confirmation. 
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4.4.2. Program startup 

When it is enabled, the sureSIGHT will be started up automatically when restart PC. 
 

4.4.3. Auto redial 

When it is enabled, the sureSIGHT will reconnect the sites that are disconnected 
unexpectedly, normally it is due to network problem. 

 

4.4.4. Default path 

To set the default storage path for import/export, footage extraction and reference 

picture, etc. click , and browse for a folder for storage. 
 
The path will show on {System settings panel} when success. 

 

 
 

4.4.5. Event alert settings 

Click to enable/disable event alert sound. 

 

4.4.6. siteCHECK settings 

 

Step 1. To modify the setting, go to [System] -> [Settings] -> [siteCHECK]. 
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Step 2. You can enable or disable siteCHECK function, set the start time and time 
interval. You can select pre-set time interval or customize the site interval. 

Step 3. You can enable siteCHECK warning, siteCHECK warning alert and status 
checking. 

 

Enable siteCHECK warning alert. : Alert users when siteCHECK result with 
warning. 
Site is not local recording. : Tick to enable warning for site that is not currently 
local recording. 
Recording status: Check sites recording status. 
Arm/Disarm status: Check sites arm/disarm status. 

 

Step 4. To edit siteCHECK list, you can click [siteCHECK] tab and click 
[siteCHECK list] tab. Click the check box in the front of the site name to change 
the selection status.  
 

Step 5. To edit 3G site list, you can click [3G site list] tab. Click the check box in the 
front of the site name to change the selection status.  

For 3G network sites, the number of connection retry will be tripled when a site 
failed to be connected. 

Step 6. Click [ ] button to save the modification. 

Please refer to section 16.1 for siteCHECK result checking. 
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4.4.7. Default live video view layout 

In [Video settings] Tab, you will be able to make change of video settings. 
 

It will make the default video view changed when logged in sureSIGHT. 
 
Click the Options icon, the live video view list is shown, 
 
Select a suitable video view, the icon on {System settings panel} when setting is 
successful. 
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4.4.8. Language 

The default language to be displayed of sureSIGHT is English, to change the 
language to be displayed, you should select [System] -> [System settings…] -> 
[General system settings] -> [System language…] from {Main menu}. 
 
In {Language selection} window, select the language from the drop down menu, the 
language to be display will be changed after restart sureSIGHT. 
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5. Site management 

sureSIGHT allows you to manage the site information. 
 
To open the Site management window, you should select [System] -> [Site 
Management…] from {Main menu}. 
 

5.1. Working environment  

 
 
In {Site management} window,  
Panel Name Description 

1 Site list The group/site have been added to the system. 

2 Information 
panel 

Information about the selected group/site. 

3 Control 
panel 

Contain buttons for site management function. 
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5.2. Add sites  

5.2.1. Add site manually 

5.2.1.1. Add site manually 

To add a new site, follows the steps below 

Step 1. In {Site management}, click [ ] button or right click in the space of Site 
list and select [Add site manually].  
 

Step 2. {Connect or Add site} dialog is shown. 
 

Step 3. Select Site types. 
 
Step 4. Input basic camera information such as Site name, Connection type, 

IP/sureLINK, Username and Password.  
 
*** Site name and IP/sureLINK cannot be duplicated with other sites added in 
sureSIGHT. 
 
Step 5. For JN/VN, If you want to add the site via P2P, select [P2P] in Connection 

type and input the MAC. 
 
*** MAC is the MAC address of the JN/VN (Login to the JN/VN and go to Main Menu � 
Information � Network to check the MAC address). 
 
Step 6. Click [Other information >>] to input additional information. 
 
***Serial number and Registration code are required if registration checking is enabled. 
 
Step 7. Click [OK] button to save the site. 
 
 

5.2.1.2. Alternative way to add a site 

 
Step 1. Two methods are available to add a site in {Main Panel}. 
 
*** The following steps support adding a site and connecting a site.  
If you input IP that has been added to site list, the site will be connected. But, if you 
input new IP, you can add the site and it will be connected automatically. 

 
 

 
Method 1:  

You can click [ ] button on {Main panel} 



sureSIGHT Lite/Business 39

 

Method 2: Input IP in [ ], Then click [Enter]. 
 
 
Step 2. A dialog to connect or add a site is shown. 
 
Step 3. Input IP that has not been added to site list. The remaining steps it will be 

similar to Chapter 5.2.1 ”Add site manually”. 
 

 
 

5.2.2. Add site by searching 

To add new sites, follows the steps below 

Step 1. In {site management}, click [ ] button. 
 

Step 2. The searched sites are shown. 
 

 
  

[Show new site only]: Search the sites that are not added. 
[Group]: Select user group for the selected sites. 

 
Step 3. Select sites and click [Next>>]. 
 
Step 4. Input connection details for TeleEye sites such as username, password. 

Then click [Next>>]. 
 



sureSIGHT Lite/Business 40

***For using “Advanced security” mode, please refer to Appendix 25.4 Security 
mode. 
 

Step 5. The sites that are authenticated successfully will be highlighted in green. 
Otherwise, it will be highlighted in red. 
 
If any site failed for authentication, a message will be popped up, you can click 
[Yes] button to skip these failed sites, or click [No] button to stay in current page 
to edit the connection details. 
 

 

 
 
Step 6. If you want to edit configuration details, click [Details] button. The 

configuration details edit dialog is similar to Chapter 5.2 Add sites. 
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Step 7. Click [Finish] to add sites. 
 
 

5.3. Add a group  

To add a new group, follows the steps below 
 
Step 1.  

 

Click [ ] button on the {Site management} or click right button in the Site list 
and select [Add a group]. 
 

 
Step 2. {New group} Dialog box shown, you are required to input a unique group name. 

 

 
 

Step 3. Then select throughput limit for this group. 
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Step 4. Click [ ] button to save the group information. 
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5.4. Site grouping 

After adding a set of site and group, you can group the site by Drag & Drop in the site 
management dialog box which can help you to organize the sites into group for 
monitoring 
 
Select a Group, the site member will be shown in Information panel and drag the site into 
the group folder directly. 
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5.5. Edit a site  

Follow the steps below to edit site information.  
 
Step 1.  

 
Method 1.  
In {Site management}, click [Edit] button or right click the site in Site list and select 
[Edit]. 
 
Method 2.  
In Main Panel, right click the site in Site list and select [Edit site]. 
 

 
Step 2. You can edit information of the site. 

 
Step 3. After finished, click [OK] button to save the site information. 
 

5.6. Edit a group 

Follow the steps below to edit a group.  
 
Step 1. In {Site management}, select a group to edit, and click [Edit] button or right 

click the group in Site list and select [Edit]. 
 

Step 2. You can change the name of the group, when finished, click [ ] button to 
save the group information. 

***The group “Sites” cannot be edited 
 

5.7. Remove a site  

Follow the steps below to remove a site. 
 
Method 1. 

In {Site management}, select site to delete, and click [ ] button. 
 

Method 2.  
In Main Panel, right click the site in Site list and select [Delete site]. 
 

5.8. Remove a group  

To remove an existing group, select one of the groups from Site list and then click [Delete] 
button by right click or click [Delete] on {Site management}. System will require you to 
confirm the operation. 
 

5.9. Search for a site  

If there are a lot of sites have been added in the site list, it’s difficult to search for a site 
manually, you can use the search method to select a site. 
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To search for an added site, follows the steps below 
 
In {Site management} dialog 
Step 1. Click [Search a site] button on the {Site management}, 
 
Step 2. You are required to input a keyword for searching. 

 
Step 3. Click [Search] button to start search. 

 
Step 4. Based on the Filter selected, the result will be shown in Result box. 
 
Step 5. Select the site you want then click [Close]. 
 
  



sureSIGHT Lite/Business 46

6. Account management  

**Only Administrator group users are allowed to manage user account, before the 
following account management task, please login as administrator group users first. 
 
To open the Account management windows, you should select [System] -> [Account 
Management…] from {Main menu}. 
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Working environment 

 

 
In {User account management} dialog box,  

Panel Name Description 

1 Account list The list of User account according their group added to the 
system 

2 Group panel Account details box show the rights of Group 

3 User panel User details include user name and password 

4 Control 
Panel 

Contain buttons for account management function 

5 Tab panel Group and User Accounts, Site monitoring right and 
Sitemap monitoring right. 

6  Enable/Disable user account support 

7 Auto login Enable/disable auto login function. 
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6.1. Enable user account support 

***The default user account support is disabled.  
 
If the user account support is disabled, no login is required. 
 
To enable user account support, tick [Enable user account support (sureSIGHT 
restart is required to change this settings.)] 
 
 

6.2. Enable auto login 

If you want sureSIGHT to login to a specified user when startup, you can click Auto login: 
and select a user. 

 

6.3. Add a group 

To add a new user group, follows the steps below 
 
Step 1. In Control Panel, click [New group] button or right click in the space of Account 

list and select [New group]. 
 

 
Step 2. A new group form in Account list, you can rename the group in a unique name 

in Group panel. 
 
 

Step 3. Under Group Panel, administrator can permit the function to group of user 
(Hints: There a tool tips for you when mouse hold on the functions) 

 
Step 4. Click [OK] button to save the group setting 
 

6.4. Add a user 

To add a new user, follows the steps below 
***The new user under the group will gain the permit of that group. 
 
Step 1. In Account list, select a group of user, then click [New user] button in Control 

Panel or right click in the group of Account list and select [New user]. 
 
 

Step 2. A new user form in Account list, administrator can rename the user and his 
password in a unique name in User panel. 
(***Remark: Default password for all new user is 000000) 

 
Step 3. Click [OK] button to save the user setting 
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6.5. Change user name or password 

To Change user name or password of a user, follows the steps below 
Administrator does not need to know the user password. 
 
Step 1. In Account list, select a user, type in the new user name and password under 

User panel. 
 

Step 2. Click [OK] button to save the user setting 
 

Delete a group 

To delete a user group, follows the steps below 
Step 1. In Account list, select a group of user, then click [Delete group] button in 

Control Panel or right click in the group of Account list and select [Delete group]. 
 
 

Step 2. A warning message prompt and ask you to remove the group or not. Click [yes] 
to continuous. 
(***Remark: all of the user under the group must be removed before this step) 

 

6.6. Delete a user 

To delete a user, follows the steps below 
Step 1. In Account list, select a user, then click [Delete user] button in Control Panel or 

right click the user in Account list and select [Delete user]. 
 

Step 2. A warning message prompts and asks you to delete the user or not. Click yes to 
continuous. 

6.7. Assigning group right 

To Change the right of a user group, follows the steps below 
 
Step 1. In Account list, select a group and choose the right hope to assign to user under 

Group panel. 
 

Step 2. Click [OK] button to save the user setting 
***All of the user under the group will update their right at the same times 
 

6.8. Assigning site monitoring right 

To change the right of site monitoring follows the steps below 
 
Step 1. In Tab panel, select “Site monitoring right”.  
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Step 2. In Group List, Choose an user group 
 

Step 3. The selected user will be assigned for the site monitoring right to the sites with 
checked box. 

 
 
Step 4. Click [OK] to save the setting and exit 
***Administrators cannot assign the right of site monitoring for themselves 
 

6.9. Assigning siteMAP monitoring right 

To change the right of site monitoring follows the steps below 
 
Step 1. In Tab panel, select “siteMAP monitoring right”.  
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Step 2. In Group List, Choose an user group 
 

Step 3. The selected user will be assigned for the site monitoring right to the siteMAP 
with checked box. 
 

 
 

Step 4. Click [ ] to save the setting and exit 
***Administrators cannot assign the right of siteMAP monitoring for themselves 

 



sureSIGHT Lite/Business 52

7. Remote Live Monitoring 

Remote live monitoring system is multi-sites monitoring system. 
sureSIGHT Lite/Business can support 16 to 64 cameras from difference sites. 
 
 

7.1. Working environment 

 
 
In Live View panel  

Panel Name Description 

1 Video view 
selection 
panel 

Layout image button for change the layout of Camera 
frame area 

2 Video 
display 
panel 

A sizeable area to show the camera frames. 

 

7.2. Connect a site, camera or group 

To connect a remote site, camera or group, you must setup the site list first. Refer to 
the chapter 4 for setting up a site list. 
You can build up a connection profile to {Connection profiles list} by the added site. 
Refer to chapter 8 for detail. 
 
After setting up the {Connection profiles} and site list, you can connect a camera to 
[Video display panel] by the following me: 
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1. Dragging a site, camera or group from {Connection profiles} to a [Video 

display panel] 

 
 

2. Double click a site, camera or group on {Site list} 
 

3. Double click video view on {Connection profile list}  

Input site name or IP address in [ ] and 
click [Enter] in {Main Panel}, Then, Click [OK] button to connect. 

 
 
 

4. Click [ ] in {Main Panel}, then input IP that already added to site list. 
Then, Click [OK] button to connect. 
 
 

5. Right click a site, camera or group on {Site list}, then click [Connect] or 
[Append to the end]. 
 
Connect: Disconnect all other sites, and then connect to the target sites. 
Append to the end: connect and append target sites and keep all current site 
connections.   
 
  



sureSIGHT Lite/Business 54

7.3. Disconnection 

The selected camera can be disconnected by selecting the [Remove cam] button on 
the right-click menu of a [Video display panel]. 
 
 

Disconnect a site can be done by selecting the [Remove all camera of selected site] 
on the right-click menu of [Video display panel] or selecting the [Disconnect 
selected site] on the right click menu in site connection status table. 
 

 
 

Disconnect all sites can be done by selecting the [Remove all site] on the right-click 
menu of [Video display panel] or selecting the [Disconnect all site] on the 
right-click menu in {site connection status} table. Apart from that, it can be done by 

selecting the [ ] main menu button. 
 
 

7.4. Camera frame operation 

Changing camera frame layout 
 
Selecting the layout button can change the layout of camera frame. The distribution of 
the frame is the same as the layout button.  
 
Double click [Video display panel] can enlarge the selected [Video display panel] 
to single frame layout. Double click again can restore to the original layout. 
 
Swapping videos 
 

[Video display panel] allows camera frame swapping by dragging a [Video 
display panel] to another [Video display panel].  
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Full screen 
 
Select the [Full screen] on the right-click menu of [Video display panel] or select it 
on the main menu button can enlarge the [Video display panel] to full screen mode.  
 

 
Figure 7-1 full screen button on the main menu 

 

7.5. Frame border status 

Swapping videos 
 
When dragging a camera frame to another camera frame, the border of original 
camera frame shows blue color and the target camera frame shows yellow color. 
 

 
 

Selecting the site/camera 
 
When selecting a site on the {site connection status} table. All the border of the 
camera frames of the site will show yellow color. 
 
When selecting a camera frame on the {camera frame area}, all of the camera frame 
of the site will show yellow color if the site is different from previous one. Otherwise, 
the yellow color border will be shown on the selected camera only. 
 

 
 

Error when connecting site 
 
Red camera frame border color will be shown when there is error on connecting site. 
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7.6. Auto redial 

Auto redial function can be enabled at the path of [system] -> [system setting] -> 
[General system settings] tab. 
 

7.7. Global video quality 

In sureSIGHT, you are allowed set the video quality to fulfill their network throughput. 
To set the video quality, you can follow the step below: 
 
Select [View] -> [Global video quality] from {Main menu}. 
 
Then select the quality standard for your Video 
 
Excellent > Good > Medium > Fair > Low. Lower level of video selected, less network 
throughput required for the computer. 
 

7.8. Sequential mode 

If the video panel layout is , ,  or , and total connected camera is 
more than total camera that panel can be displayed. In the case, a partial of video can 
be viewed. When Sequential mode is enabled, the video panel will display next set of 
video automatically. 
 
Follow the steps below to enable Sequential mode. 
  
Step 1. Select [View] -> [Sequential mode] from {Main menu}. 
 
Step 2. Disabled or select time interval for Sequential mode. 
 
*** you can also click same panel layout icon to switch to next set of video manually. 
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7.9. On screen display settings 

 
Step 1. To change the text display and text color settings, you should select [View] 

-> [On Screen display settings…] 
  
Step 2. The {On screen display setting} window is shown. 

       

 
 

� To set the POS and Access control data 

 
In POS and Access control data box, click [Show on POS and Access control 
data on the video] to allow display of the POS data 

� Color: Color of the POS message 
� Font Size: Size of the font appear on the screen 
� Text Region: The alignment of the text appear on screen 
� Text Transparency: The transparency of the text show on the screen 
� Remove message time out: The waiting time for the received message 

remove. 
    

� To set the camera name and date display 
 
In Camera name and date box, click [Show camera name and datetime on the 
video] to show the camera name and datetime, the display of text will change as 
below. 
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� PTZ function icon 

Check the checkbox to enable display that icon on the screen. 
  

� Recording status icon 

Check the checkbox to enable display that icon on the screen. 
 

� Others 

Check the checkbox to show capture image to PC icon on the LIVE video. 
 

� Event status 

Check the checkbox to enable show color to indicate event on LIVE video. 
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7.10. Video settings 

Video setting function allows you to adjust the properties of the videos. Different 
camera has different properties.  
 
All properties list below: 
� Brightness/Contrast/Saturation 
� Mirroring 
� Exposure 
� White balance 
� Flickerless control 
� Iris control 
� Sharpness 
� Sense up 

 
***The basic unit of video properties is site. In the other words, changing a video 
setting of a selected camera will apply that setting to all cameras at the site. 
 
To access the video setting window, click [video setting…] on the right click menu of 
a [Video display panel]. 
 
Brightness/Contrast/Saturation 
 
You can adjust brightness, contrast and saturation. The live camera view will be 
instantly changed by adjustment. 
 
Mirroring 
You can flip the view. The live camera view will be instantly changed by adjustment. 
 
Exposure 
You can adjust the exposure to longer and shorter. The live camera view will be 
instantly changed by adjustment. 
 
White balance 
You can select auto adjust, indoor and outdoor white balance adjustment. The live 
camera view will be instantly changed by adjustment. 
 
Flickerless control 
You can adjust auto flickerless control, flickerless control within 50Hz or 60 Hz. The 
live camera view will be instantly changed by adjusting. 
 
Iris control 
You can adjust the iris of the camera. User should check the box of auto adjust before 
they set the DC level. DC level higher, the image will be brighter. You can also adjust 
the auto iris sensitivity level. 
 
Sharpness 
You can adjust sharpness of the image. The live camera view will instantly change by 
adjusting. 
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Sense Up 
You can enable sense up feature to extent exposure time in low light environment. 
 

7.11. Video Display Module 

sureSIGHT supports two video display modules: Direct3D and GDI. The selection 

between Direct3D and GDI depends on computers. Basically, most computers 

support GDI, however, Direct3D gives you a better video quality. For the computers 

that do not support Direct3D the default setting is GDI. However, some computers 

may not completely support Direct3D. In this case, GDI is recommended to be used. 

If the video quality is not good enough, one of the possible reasons is that the 

computer does not support Direct3D very well. You may compare these two 

modules and select the better one.  
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8. Connection Profile Management 
sureSIGHT allows managing the connection profile information. 

In this section, you will learn the followings: 

 

� Add a new group 

� Edit a connection profile group 

� Delete a connection profile group 

� Add a new connection profile 

� Edit a connection profile 

� Delete a connection profile 

 

8.1. Working environment 

 

 

The {Connection profiles} allows you to manage connection profiles and their 

grouping. 

 

8.2. Add a new group 

In {Connection profile list}, right click and select [Add a group…]. 

 

Input a new name for the {Connection profile group} and click [tick] button to add 

a new group. 

 

8.3. Edit a connection profile group 

In {Connection profile list}, right click and select [Edit group]. 
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Input a new name for the {connection profile group} and click [ ] button to 

change the name of the group. 

8.4. Delete a connection profile group 

In {Connection profile list}, select a group, right click and select [Delete a group]. 

 

8.5. Add a connection profile 

In {Connection profile list}, right click and select [Add a connection profile…]. 

 

{Add a connection profile} window is shown.  

 

 

In {Add a connection profile} window,  

Panel Name Description 

1 Site list Shown the information of the added sites. 

2 Connection 

profile 

properties 

Shown the name and layout of the connection profile. You 

can select different connection profile to support different 

number of sites. 

(Remark: The name of the site is unique.) 

3 Connection 

profile layout 

Show the layout of the connection profile. You can drag a 

camera or a site from the [Site list] to the grid of 

connection profile layout. 
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Select the name and layout of the connection profile in Connection profile 

properties. 

***Name of the site must be unique  

Drag a cam or a site from the Site list to the grid of Connection profile layout. 

Click [Tick] to add the new connection profile. 

8.6. Edit a connection profile. 

In {Connection profile list}, right click and select [Edit connection profile…]. 

 

After editing the properties of the connection profile, click [Tick] to save the modified 

setting. 

 

8.7. Delete a connection profile:  

In {Connection profile list}, Select a connection profile, right click and select 

[Delete a connection profile]. 

 

8.8. Apply a connection profile: 

In {Connection profiles}, Select a connection profile, double-click and the live 

camera windows will apply the connection profile setting. 

8.9. Default connection profile 

You can set a connection profile as default connection profile. The default 

connection profile will auto be connected after sureSIGHT startup. Only one default 

connection profile is supported. 

 

To setup default connection profile, right click on a connection profile and select 

[Mark as default connection profile].  

A [ ] indicator will be show before default connection profile name. 
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9. Recording 
Remote Server Recording is performed at the server. It provides high reliability 

video recording and supports schedule recording. Its flexible settings can make a 

balance between video quality and recording capacity to satisfy your needs. 

 

*** Only TeleEye site support recording settings 

 

Click  button.  

Click [Recording] on the left. 

 

In this section, you will learn the followings: 

� Remote server recording setting 

 

9.1. Remote server recording setting 

 

 

Disk Mode: Cyclic disk mode will erase the oldest recording data when the hard 

disk is full, that is to say the old data will be replaced. On the other side, fixed disk 

mode will stop recording when the hard disk is full. 
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Quality: This is the quality of the recorded video. The quality is divided into 5 levels 

(in ascending quality order): low, fair, medium, good and excellent. 

 

Image Size (Resolution): This is the display resolution for the recorded video. “Full” 

means the resolution is suitable for full size display. “Quad” is suitable for quarter 

size display. Noises may arise if you play “Quad” image size video in full size mode.  

 

 

 

Recording Mode: Manual recording provides 7 recording modes, 1 fps (frame per 

second), 2 fps, 3 fps, 4 fps, 5 fps, 100 fps and continuous mode. In 1 fps mode, the 

recording frame rate is less, so the storage size is small. In continuous mode, the 

recording frame rate depends on the number of recording camera and the storage 

size is larger. 
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Audio Settings: Select the audio channel to be recorded on the left. And select the 

recording quality at “Audio Quality”. 

 

 

 

Schedule Recording 

 

This function can set up a recording schedule to the transmitter. You only needs to 

add a new schedule and the start/end time of recording. 

 

Step 1. Click [Scheduled Recording] button 

 

Step 2. {ADD} panel and {Add Schedule Recording} will pop up. 

 

 

 

Step 3. Select either {Normal Recording} or {Motion Recording} 
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Step 4. Select the weekday/s to record 

 

Step 5. Click {All Day} if you wish to record for a week. 

 

 

 

Step 6. Set the Start/End time of the recording 

 

 
 

Step 7. Select recording frame rate 

 

 

 

Step 8. Select the camera to be recorded 

 

 

 

Step 9. Click [Ok] to save and exit. 
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Step 10. The Recording icon will change to schedule recording when recording 

start. 

 

 
***Recording right: 

System administrator can grant recording right to normal user. The detail setting can 

be reference to the chapter 6. 

Manual Start/Stop recording 

 

Authorized users can enable/disable the remote server recording by clicking the 

[REC] button on the system information panel, onscreen button. 

     
 

 

For starting the recording, you must select the recording type and which camera is 

going to record. 

 

 

For unauthorized users, the [REC] button acts as an icon to shows the recording 

status. 
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10. Playback Operation 
Video recorded by server or sureREC, can be played by the playback function. 

To start the remote server playback, click [Playback] button in main menu button  

 

 

 

In this section, you will learn about 

� Open the Playback log 

� Using the Playback log 

 

10.1. Open the Playback Log 

Start Remote Server Playback 

 

Working environment 
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In {Playback} window,  

Panel Name Description 

1 Playback 

site list 

List the sites and NX/MX cameras have been added for 

playback 

***In full screen mode, the time bar will auto hide when mouse move away the  

 

10.2. Using the Playback Log 

Besides the existence of video, you can observe past events from the playback log.  

To show the recording log, there are two methods.  

 

Playback log 

Double click a site of the [Playback site list]. Recording log windows will be shown: 

 

 

In {Recording log} window,  

Panel Name Description 

1 Time slot 

and Event 

matrix 

Indicate the cameras and their event in a period of time slot. 

2 Time slot 

zooming 

Select the time slot to display in Time slot and Event 

matrix  

 

In Time slot and Event matrix, the time line will appear in sharp color. The grey color 

represents no recording log there. 

 

Icon Meaning 

 Manual recording 

 No recording log 
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 Manual recording with audio 

 Recording record match with search result 

 

In each recording log, there are different icons to represent different events. Details 

information will appear when the cursor is moved over it. 

 

 

 

Icons represent event types and status while numbers represents sources. Table 

below lists all the icons in playback log and the corresponding events they stand for. 

 

Icon Meaning 

  

Alarm has been triggered. 

 

Alarm is triggering. The icon will keep flashing. 

 

Motion has been triggered. 

 

Motion is triggering. The icon will keep flashing. 

 

Video loss has been triggered. 

 

Video loss is triggering. The icon will keep flashing. 
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Bookmark that time interval 

 

You can search the recording time or directly click  

button to playback video. 

  

Select the time scale by using  icon to view the log clearly in 

order to select a more precise time. You can use the scroll button on the mouse to 

zoom in/out to the log. 

 

  
 

Click  buttons to move the time bar to do navigation. 

 

  
 

Click the graph to select the time to play. For example, in the following Figure, there 

is a motion event at 11:30. Click the chart around11:30 and a blue line will appear 

which mean you selects this time. 

 

For the sites support multiple camera playback, you can select cameras to do 

playback. 
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Click [Play] button  to start the video playback. 

 

Control the video by the control buttons on the bottom-left of the playback control 

 

 

 

During playback, you can modify the speed of playback, cameras and screen mode 

according to your need. 

Playback control 

 

Icon Title Description 

 

Backward Play video backward 1 frame per minute. (Not 

supported in JN/KN) 

 

Pause Pause the video playback. After pausing the video for 

1 minute, the software will continue to playback 

automatically. 
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Forward Play video with fast speed. 

 

Stop Stop to play the video and go back to playback log. 

You can select another video to playback or click 

[Back To Live] button to return to the main panel. 

 

Normal Play Play video with normal 1x speed. 

 

Fast Forward Click [Forward] button twice to play video with very 

fast speed. 

 

Step 

Backward 

Click [Backward] while video is pausing to display 

one frame per click. (Not supported in JN/KN) 

 

Step Forward Click [Forward] while video is pausing to display the 

next frame. (Not supported in JN/KN) 
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Playback with audio 

 

You can play recording audio during video playback. 

 

Click [Playback audio] and select audio channel or mute. 
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Playback thumbnail 

You can select a time in the recording to show the corresponding playback thumbnail for 

you to quick review of what is happing on the time period before you started playback the 

actual video. 

 

You can click the checkbox of the playback thumbnail to select the camera and click 

the middle of the thumbnail to start playback. 
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Playback spot search 

 

If you want to search for something you are interested in, but you just know roughly 

the time period of the interesting thing happened. You can use the playback 

thumbnail search mode to help you to locate the more accurate time. 

 

(1): To start thumbnail search mode. 

(2): The search start datetime. 

(3): The search end datetime. 

(4): Show eariler thumbnail. 

(5): Show later thumbnail. 

(6): Increase the search time. 

(7): Decrease the search time. 

(8): Set the search period to all time on the current recording log. 

(9): Change the scale of the search time. 

(10): The searched thumbnail. 

To start with this mode, you need to click on the  (1) button. 

If you know the time period that the event happened, you can drag and move the 
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search area  to cover the period. The thumbnail images 

within the period will be shown in area (10). If the event happened between 2 

thumbnail, you move the cursor on the thumbnail and click the  to zoom in. For 

example: if you want to view the thumbnail between 07:50 and 08:00 

, 

You click the  on the 08:00 thumbnail, and you will get the thumbnail in 1 min 

interval as below. 

 

 

If it is still not what you are looking for, you can then zoom out  or navigate on an 

eariler  or later time . Once 

you find the thumbnail that show the event. You click click on the  icon on the 

video to start playback directly or click  to show the recording log on that time. 
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11. Pan Tilt Zoom (PTZ) 
Pan Tilt Zoom (PTZ) 

In this section, you will learn about 

� Analog PTZ 

� Digital PTZ 

 

11.1. Analog PTZ 

Administrator can grant the Analog Pan Tilt Zoom (PTZ) function to normal user 

group. Detail operation can be reference to chapter 6. 

 

1. Start PTZ function 

If a site with analog PTZ function is connected by authorized user,  icon will 

be shown in the top left corner of the video.  

 

To use the analog PTZ function, you can click the  icon.  

 

To do the basic operation on Pan, tilt or zoom on the PTZ camera, you can move the 

cursor on the video and do mouse left click to make the PTZ operation. 

For example, if you want to pan left, you should move the cursor on the left hand 

side of the video panel. When mouse cursor will change to [ ], you can click the 

left mouse button pan the camera to the left. 

 

2. Set pan tilt speed 

The speed of the pan and tilt can be set on right click menu of the video. 
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3. Call preset position 

It contains 16 numeric buttons for 16 preset locations. The PTZ camera view moves 

to the pre-defined preset location when the button is clicked if that button is set in 

[Program Preset]. 

 

 

 

4. Recall patrol 

It contains 4 patrol and stop buttons, which are used to activate the patrol tours of 

the selected PTZ camera model. When the [Patrol 1,2,3,4] button is clicked, the 

camera starts the tour until the patrol operation is cancelled (i.e. [Stop Patrol] 

button is clicked). 

 

 

 

Click [Disable PTZ control] to disable the analog PTZ function. 
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5. Save preset point 

The PTZ functions for step 1-4 are also available in PTZ control panel. Besides, 

you can set preset point in PTZ control panel. 

To go to PTZ control panel, Right click the video screen and select [PTZ control 

panel...].  

 

 

 

The PTZ control panel will be shown. 
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Select [Program preset]. Then click [Program] and select one preset point, the 

current position will be saved.  

 

6. Edit patrol 

In PTZ control panel, you can edit patrol. 

 

 

Click [Add] and select a preset point. Besides, you can click [Delete] to delete 

the preset point. 
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7. Focus, Iris and other settings 

 

Icon Description 

 

Focus far 

 

Focus near 

 

Iris open 

 

Iris close 

 

Washer 

 

Wiper 
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11.2. Digital PTZ 

sureSIGHT supports digital PTZ function. It allows you to focus on a particular area 

to see it more clearly. 

 

There are 2 methods to do digital PTZ: 

 

Method 1: 

Mouse left click on the video and drag the area you are interested in, and click the 

 button. 

 

 

If you want to restore the video, you can click the  button. 
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You can zoom the video on another video windows by click the  button, you 

can drag at most 3 areas if there is enough free windows. 

 

The zoomed area will be colored in 3 different colors in the original video, and the 

corresponding videos will be shown on the free windows with the colored border. 

 

In the zoomed windows, you can click the  button to close it. 
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Method 2: 

 

Click the  button,  

 

and move the cursor to the area of interest and click on it, you can zoom to at most 5 

times of the original video. After you have zoomed in a video, you can do PAN and 

TITE to move the zoomed video to another area. 

 

You can also do zoom operation by drag the zoom track bar and zoom in and out 

buttons. 
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If you want to restore the video, you can click the  button. 
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11.3. Computer aux port 

PTZ function can be easily controlled by the dedicated TeleEye KB03 and other 

Pelco-P/D compatible keyboards to make control more convenient. 

 

To use TeleEye KB03 keyboard to control PTZ, the following setting must be equal 

between sureSIGHT and TeleEye KB03 keyboard. 

 

The default settings: 

Baud rate: 4800 bps 

Parity: None 

Data length: 8 

Stop bit: 1 

 

11.3.1. Software setting 

Step 1. To set up the external device, connect the external device first (It should be 

the COM port of the PC to the COM port of the KB03). Then, choose [System] 

-> [Computer aux port...] . 

 

Step 2. Check the [Enable computer aux port], choose the COM port connecting 

to the device and choose keyboard types.  

 

Step 3. Change keyboard types to “TeleEye KB series”. 

 

Step 4. Set up the communication details of the COM port through [Advanced 

setting]. Make sure the settings are same as KB03 settings. 
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Step 5. Click [ ] to finish the settings. 

 

11.3.2. KB03 keyboard settings 

Step 1. Connect computer COM port to KB03 COM1 port.  
 

 

 
 
Step 2. Press SET key on KB03 keyboard and hold it for 2 seconds, LCD displays 

 
 

Step 3. If there is a password, you must input the 6-bits password correctly. 
 

Step 4. Enter submenu or return to upper menu level 
Enter submenu: press the item number on keyboard numeric pad, or move the 
joystick up and down to the item number. 
Return to upper menu level: move the joystick left to return to the upper menu 
level. 
Save the selection: Press the corresponding numeric key to select and save 
selection. The save result dialog will be shown on the screen. 
 

Step 5. KB03 COM1 settings. 
1. Select Comm Port Setup 
2. Select COM 1 
3. Set Baud rate, Parity, Data length or Stop bit respectively. 

  
 

Step 6. Go back to main menu for Mode settings. 
The protocol for KB03 must be same as your camera PTZ protocol. 
1. Select Mode Setup 
2. Press corresponding numerical key to select required protocol.  
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11.3.3. KB03 basic operation 

Press numerical number at keyboard and press [CAM] button. The camera will be 
selected. 

 
 
Use joystick for controlling the pan/tilt of a camera, it also can do lens ZOOM 
operation.  
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12. siteMAP 

 
To open the Sitemap management windows, you should select [Value-added Module] 
-> [siteMAP management…] from {Main menu}. 

 
 

Working environment 

 

 
In {siteMAP management} window,  

Panel Name Description 

1 Site Describe The siteMAP information with name, associated connection 
profile/site, description and Preview. 

2 Control 
panel 

Contain buttons for siteMAP management function 

3 SiteMAP list List of the stored siteMAP  
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12.1. Adding a siteMAP 

 
To add a new siteMAP, In {SiteMAP management} windows, follows the steps below 

Step 1. In Control Panel, click [add a siteMAP]  button 
 

Step 2. A new window {Add a new site group} is shown.  
 

Step 3. At the top of {SiteMAP management} window, you should provide a unique 
SiteMAP name, Map association, Background picture and description. 
 
(Hints:  
Map associated to a site – When the associated site is connected, this siteMAP will 
be shown.  
Map associated to a connection profile– When the connection profile is using, this 
siteMAP will be shown.) 
 

Step 4. Click [ ] button to navigate to siteMAP editor. 

 
 

12.2. siteMAP editor 

sureSIGHT will automatic jump to siteMAP editor after generating a new siteMAP, you 

can also edit the selected siteMAP by click [edit]  button in {SiteMAP 
management} window. 
 
 
A new window {SiteMAP editor} shown 
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In {SiteMAP editor} window,  
Panel Name Description 

1 Tools panel Edit tools for the component map, associate component and 
components tables 

2 Components 
Box 

Contain all the possible components for a well structure 
siteMAP 

3 Components 
siteMAP 

A siteMAP to graphical display the location of different 
components in the floor plan. 

In {SiteMAP editor} window, the components in components Box represent different 
components 
 
Icon Name Representation 

 

Cameras  Camera type, direction and location 
Video loss event 

 

Preset Point Programmed position for pan tile zoom camera 

 

Sensor Sensor type and location 
Sensor event 

 

Motion Motion sensor location 
Motion event 

 

Switch Switch status 
Change switch status button 

 

PA Quick button of public address function 

 

Audio 
Reception 

Quick button of Audio Reception function  
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Video Servers Video server type and location 
Quick button to connect to a site 

 

Site Indicator Connection status of a site 
Quick button to connect to a site 

 

Group Indicator Connection status of a list of sites 
A link to another siteMAP 

 

Link A link to another siteMAP 

 

Connection 
profile 

A connection profile that is related to the current 
siteMAP 

 

Text Text 

 

Line Line 

 

Rectangle Rectangle 
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12.2.1. Select site form 

To check the full name of the camera connect to siteMAP, you should select [Click to 
change site] from {Tools panel}. 
 

 
 
In {Show all sites} window, 
All available sites will be shown, you can choose a site they desired, the site 
information and their code will be shown, 
 

 
 

12.2.2. Components table 

To check the full name of the camera connect to siteMAP, you should select [Click to 
change site] from {Tools panel}. 
 

  
 
In {Component tabel} window, it shows the connected components of sureSIGHT. 
 



sureSIGHT Lite/Business 

 
  

12.2.3. Cursor shapes 

There are three types of cursor shapes in siteMAP editor form. “ ” means you can 

move components; “+” means you can add new components and “ ” means you 

can delete the selected component. Click buttons in components menu bar will 

change the cursor to “+”, click mouse right button on a selected item will change the 

cursor to “ ”, you can also click [Edit] button to change cursor shape to “ ” or 

[delete] button to change cursor shape to “ ”. 
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12.2.4. Adding and Editing components 

To add/edit components to the Components siteMAP, follows the steps below. 
 

Adding a components: 
 
Step 1. Click the components in Components Box  

 
Step 2. A new set of Type appear 

 

 
 
Step 3. Select the desire type of components 

 

Step 4. The cursor will change into cross“+” 

 
Step 5. The components will form in Components siteMAP when you click it. 
  

Edit an existing component: 

Step 1. In Tools panel, switch to [Edit or Move]  button. 
 

Step 2. The cursor will change into arrow“ ” 
 

Step 3. Select the components in Components siteMAP 
 

Now you can drag and drop to move the components. 
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12.2.5. Deleting components 

To delete a component on the Components siteMAP, follows the steps below. 
 

Deleting an existing component: 
 

Step 1. In Tools panel, switch to [Delete a component]  button. 
 

Step 2. The cursor will change into stop symbol“ ” 
 

Step 3. Select the components in Components siteMAP 
 

Step 4. Confirmation to remove the components. 

 

12.3. Editing a siteMAP 

To edit a siteMAP, click  button in {SiteMAP management} window.  
 

Edit a siteMAP: 

Step 1. In Tools panel, switch to  button. 
 
A {Edit siteMAP} window appear 
 

Step 2. You can correct the name of the siteMAP, Map association and Description 
 

Step 3. Confirmation to update the settings. 
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12.4. Import and export siteMAP 

To export a siteMAP, follows the steps below. 

 
Export a siteMAP: 
Step 1. To open the {System export windows}, you should select [System] -> 

[System backup] -> [Settings import and export] -> [Export…] from the menu 
bar.   
 

Step 2. In {System export} windows, tick the checkbox of Sitemap to the export file. 
 

Step 3. Click [Export] to selected folder. 
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To import a siteMAP, follows the steps below. 

Import a siteMAP: 
 
Step 3. To open the {System import} windows, you should select [System] -> 

[System backup] -> [Settings import and export] -> [Import…] from the menu 
bar. 
 

Step 4. In {System import} windows, tick the checkbox of Sitemap to the import items. 
 

Step 5. Click [Import] to restore the siteMAP. 

 

12.5. Working with siteMAP 

12.5.1. siteMAP monitoring right 

 
To assign a siteMAP monitoring right, follows the steps below. 
 
Step 1. To open the {User account management}, you should select [System] -> 

[Account management…] from {Main menu}. 
 

Step 2. In {User account management} windows, select “sitemap monitoring right” tab 
buttons. 
 

Step 3. Select the Group of user in Groups list, and tick the allowed siteMAP to the user 
group. 
 

 
 

Step 4. Click [OK]. 

 

12.5.2. siteMAP viewer 

After setting the siteMAP, to use the siteMAP function, follows the steps below. 
 
Also, to view the Sitemap, you should select [System] -> [Sitemap viewer…] from 
{Main menu}. 
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Step 1.  Select [System] -> [Sitemap viewer…] from {Main menu}. 

 
 
In {SiteMAP viewer} window,  

Panel Name Description 

1 SiteMAP 
panel 

So the sites map of the file default 

2 Control 
panel 

Contain buttons for siteMAP management function 

 
Step 2. Select siteMAP table in the Control panel 

 

 
 

Step 3. In {siteMAP Viewer Form} you are allowed to: 
 
Fix a siteMAP picture: Fix a siteMAP can prevent siteMAP from loading caused 
from outside, for example, if the siteMAP setting “show siteMAP when associated 
site is connected” is set to be “Yes”, then whenever the associated site is 

connected the siteMAP will be shown. You can fix a siteMAP by clicking [ Fix 

siteMAP] button and it will change to [ Fix siteMAP]. To revert the setting, 

click [ Fix siteMAP] again.  
 
Display camera reference image: When the mouse hover over the icon of 
cameras, preset points, motion , site indicator or video servers, the predefined 
camera reference image will be displayed . You can disable reference image by 

clicking [ ] button, and it will change to [ ] To revert the setting, click [ ] 
again. 
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View {SiteMAP Table Form}: Click [SiteMAP Table]  button to view all 
siteMAPs in database. To load a siteMAP please double click the siteMAP name. 

 
 

Viewing History: Check the viewing history by clicking [ show history] button 
or move the mouse to the left up corner. In history box you can observe the last 
three siteMAPs visited before. Double click a siteMAP preview picture to load the 
siteMAP. 
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Step 4. The siteMAP shown on siteMAP panel 
 

 
 
Step 5. Click the component on the siteMAP panel 

 
Step 6. The components appear in main screen. 
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13. Patrol scheduler  

To open the {Patrol scheduler…} window, you should select [System] -> [Patrol 
scheduler…] from {Main menu}. 
 
In this section, you will learn the followings: 
 
� Adding a schedule 
� Edit a schedule 
� Delete a schedule 
� Start/Stop a schedule 
� Start schedule when software starts up 
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13.1. Working environment 

 
 
In {Patrol scheduler} window,  

Panel Name Description 

1 Weekly 
Patrol 
scheduler 

Show the patrol scheduler according their weekday in a 
graphical interface The date of today will highlight in yellow 
color. 

2 Patrol list Show the current schedule in list of items. 

3 Control 
Panel 

Contain buttons for patrol management function 
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13.2. Adding a schedule 

To add a new schedule, follows the steps below 

Step 1. In Control Panel of {Patrol scheduler} window, click [Add]  button. 
 
Step 2. A new {Patrol scheduler} window appears. 

 
In {Patrol scheduler} window,  
Panel Name Description 

1 Connection 
profile list 

List of the connection profile for patrol 

2 Site list The Site list for patrol scheduling 

3 Patrol Info Contain the name, schedule time, week date and 
sequential time for the patrol. 
Name: name of the patrol group 
Start time: start time of the patrol 
End time: end time of the patrol 
Day: day of the patrol operate 
Sequential time: The swapping time for patrol jump from 
one connection profile to another 

 
Step 3. In Connection profile List or Site list of the new {Patrol scheduler} windows, 

click a connection profile/site(s) for the patrol scheduling. 
***More than 1 site/Connection profile can be added for a patrol.  
 
For example: You can choose Site A and Site B in Site list, set the start time and end time 
of the patrol be 5:30 – 6:30 (Mon), and the sequential time be 15 seconds. 
Start from 5:30 of Mon, the patrol will start to shift the connection profile between site A 
and site B every 15 seconds. 
 

Step 4. Click [ ] to close and save the patrol setting, the new schedule shown in 
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patrol List and Graphical Patrol scheduler. 
 

 

13.3. Edit a schedule 

To edit a schedule, follows the steps below 

Step 1. In Patrol list, select a patrol schedule, then click [Edit] button in Control 
Panel. 
 

Step 2. {Patrol scheduler} windows appear. 
 

Step 3. Click [ ] button to save the patrol setting after the editing. 
 

 

13.4. Delete a schedule 

To delete a schedule, follows the steps below 

Step 1. In Patrol list, select a patrol schedule and click [Delete] button in Control 
Panel. 

 

13.5. Start/Stop schedule 

To start a schedule, follows the steps below 

In Patrol list, select a patrol schedule and click [Start] button in Control Panel. 
 
To stop a schedule, follows the steps below 

In Patrol list, select a patrol schedule and click [Stop] button in Control Panel. 
 
You can start/stop the patrol scheduler in the main panel also. 

 
 

13.6. Start schedule when software start up 

 
To made the patrol schedule start when start up. In Control panel, tick the box of “Run 
scheduler when system startup”. 
 

 
Then the patrol schedule will start automatically. 
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14. Event management 

***Only TeleEye sites support event management 
 
When the event triggers, the icon of the event will show on the top right hand corner 
of the viewer 
 

Icon Meaning 

  

Alarm has been triggered. 

 

Alarm is triggering. The icon will keep flashing. 

 

Motion has been triggered. 

 

Motion is triggering. The icon will keep flashing. 

 

Video loss has been triggered. 

 

Video loss is triggering. The icon will keep flashing. 

 

Arm/disarm, security switch, alarm, power failure, guard expired or 
system has been tampered. 

 

Arm/disarm, security switch, alarm, power failure, guard expired or 
system is tampering. The icon will keep flashing. 

 
Before enter the event management page, please connect to the site first. 
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To open the {Site settings…} window, you should select [Remote site] -> [Site 
settings] from {Main menu}. 
 
You can also right-click {site view}, and select [Site settings…]. 
 
Or right-click in {Site connection and event status} of {Connection info}. 
 

 
 
 
In this section, you will learn the followings: 
 
� Enable an event 
� Action for the site setting 
� Siren 
� Event status 
� Clear event 
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14.1. Working Environment:  

TeleEye sites: 

 
 
In {Site setting} window,  

Panel Name Description 

1 Setting 
Option 

The Option for Setting the site, including: 
Server setting 
Connection setting 
Recording setting 
Event setting 

2 Option panel Based on the option, the site setting and available 
operation will appear in this panel 

3 Control 
Panel 

Contain buttons for Import/Export and reload the site 
setting. 
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In {Site setting} window,  

Panel Name Description 

1 Setting 
Option 

The Option for Setting the site, including: 
General 
Network 
Datetime 
System 

2 Option panel Based on the option, the site setting and available 
operation will appear in this panel 

3 Control 
Panel 

Contain the reload, apply and cancel button 
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14.2. Event 

14.2.1. Arm/Disarm 

To Arm/Disarm a site, follows the steps below 
Step 1. In Setting Option of {Site setting} window, click [Arm/Disarm Input]. 

 

 
 
Step 2. Option panel will jump to [Arm/Disarm Input] tab. 

 

 
 
Step 3. Select Yes/No in “Enable” to enable/disable Arm 

 
Step 4. For enable the arm event, Click “Arm Setting”, {Arm Setting} windows appear. 
Step 5. In “Hardware mode”, select “Arm Type” to 

� Close: The state of the circuit is close, it indicates disarm of the site. 
� Open: The state of the circuit is open, it indicates arm of the site. 
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Step 6. Set the system tamper (for more information of tamper, please refer appendix 

21.2) 
� None: 
� Single End of Line (SEOL): 
� Double End of Line (DEOL): 

 
Step 7. In “Software mode”, setting will follow the software setting, no extra setting is 

required. 
 

Step 8. In “Schedule mode”, you should set a schedule for the Arm/Disarm, select 
[Schedule Arm/Disarm Setting], the {Schedule Arm/Disarm} windows appear. 
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In “Normal“ tab, click [Add] to add a time for enable Arm into schedule. 
 

 
 
Step 9. In the new {Add Scheduled ARM} windows, select the start time, end time and 

Weeks day for the scheduled ARM. 
 

 
 
Step 10. Schedule added into Normal schedule tab. 

 

 
To remove the scheduled ARM, you can select the scheduled ARM and click [Remove] 
button. 
 



sureSIGHT Lite/Business 

 
 
Step 1. In “Holiday” tab, click [Add] button to add a ……… 

 

 
 
Step 2. Select the start time, end time, and the start day and end day of holiday 

 
Step 3. Holiday schedule added. 
 
To remove the holiday schedule, you can select the scheduled holiday and click 
[Remove] button. 
 

 
 
Step 1. Click [Associate Switch 1] checkbox to enable associate switch 1 for 

arm/disarm input. 
(Warning message will be prompt if there are feature in switch 1) 

 
Step 2. Click [OK] to save the setting of ARM. 
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14.2.2. Security switch 

To enable the security switch of a site, follow the steps below 
Step 1. In Setting Option of {Site setting} window, click [Security Switch]. 
 
Step 2. Option panel will jump to [Security Switch] tab. 

 

 
 
Step 3. Select Yes/No in “Enable” to enable/disable security switch. 

 
Step 4. For enable the security switch, click “Switch Setting”, {Switch Setting} windows 

appear. 
 

Step 5. Select “On Type” to 
� Close: The state of the circuit is close, it indicates security switch off. 
� Open: The state of the circuit is open, it indicates security switch on. 

 
 
Step 6. Set the system tamper (for more information of tamper, please refer appendix 

21.2) 
� None: 
� Single End of Line (SEOL): 
� Double End of Line (DEOL): 

 
Step 7. Click [Associate Switch 2] checkbox to enable associate switch 2 for 

security switch. 
(Warning message will be prompt if there are feature in switch 2) 

 
Step 8. Click [OK] to save the setting of Security switch. 
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14.2.3. Alarm 

 
To enable the alarm of a site, follow the steps below 
Step 1. In Setting Option of {Site setting} windows, click [Alarm]. 

 
Step 2. Option panel will jump to [Alarm] tab. 

 

 
 
Step 3. Choose an alarm from “Alarm Name”, select Yes/No in “Enabled” to 

enable/disable Alarm. 
 

Step 4. Click [OK] to save the setting of alarm. 
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14.2.4. Motion 

To enable the Motion detection of a site, follows the steps below 
Step 1. In Setting Option of {Site setting} window, click[Motion]. 

 
Step 2. Option panel will jump to [Motion] tab. 

 

 
 
Step 3. Choose an alarm from “Camera Name”, select Yes/No in “Enabled” to 

enable/disable Motion detection 
 

Step 4. Click [Setting], the {Motion Setting} window appears. 
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Step 5. Select the detection area by the click the blue box. 
 

 
 
Step 6. Choose the “Sensitivity” level 

� Low 
� Medium 
� High 
� Custom -> you can set the custom setting with level and area scroll bar. 

 
Step 7. Click “Zone type”, the {Zone Type} window appear. 

 

 
 
Step 8. Click [OK] to save the setting of motion. 

14.2.5. Video loss 

 
Video loss can be triggered when the video channel input disappears. It will happen if 
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the transmitter receives no signal from the camera. The live camera displays a blue 
picture for video loss condition.  
 
To enable the video loss of a site, follow the steps below 
Step 1. In Setting Option of {Site setting} window, click [Video Loss]. 

 

 
 
Step 2. Option panel will jump to [Video loss] tab. 

 

 
 
Step 3. Choose a camera from “Camera Name”, select Yes/No in “Enabled” to 

enable/disable Video loss 
 

Step 4. Click [OK] to save the setting of Security switch. 

14.2.6. System tamper 

 
It is an input to the transmitter for wiring a tamper switch of the external cabinet 
outside the transmitter and its accessories. The purpose of system tamper event is to 
prevent someone to break into the cabinet and destroy the transmitter.  
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To enable the system tamper of a site, follow the steps below 
Step 1. In Setting Option of {Site setting} window, click [System Tamper]. 

 

 
 
Step 2. Option panel will jump to [System Tamper] tab. 

 

 
 
Step 3. Select Yes/No in “Enabled” to enable/disable System tamper 

 
Step 4. Select NO/NC in “Type” 

� NO: Open the sensor 
� NC: Close the sensor 

 
Step 5. Click [OK] to save the setting of System tamper. 
*** For more information of tamper, please refer appendix 21.2 
 

14.2.7. Power failure 

 
It is an input to the transmitter typically used for wiring the output signal pin from UPS. 
 
To enable the Power failure of a site, follow the steps below 
Step 1. In Setting Option of {Site setting} window, click [Power Failure input]. 
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Step 2. Option panel will jump to [Power Failure input] tab. 

 

 
 
Step 3. Select Yes/No in “Enabled” to enable/disable power failure 

 
Step 4. Select NO/NC in “Type” 

� NO: Open the sensor 
� NC: Close the sensor 

 
Step 5. Click [OK] to save the setting of Power failure Input. 
 

14.3. Action 

14.3.1. Live camera 

Event associate live camera display real time live video of pre-selected camera if an 
event triggers, so operator can immediately know what happen from the site. Live 
camera action can only display live video one time before you clears the event 
 
To set the Live camera action of a site, follows the steps below 
Step 1. In Option panel of {Site setting} window, click [Live] under Action setting. 

 



sureSIGHT Lite/Business 

 
 
Step 2. The {Live} window appears. 

 
Step 3. Tick the box of “Enable Associating Live Cameras”. 

 
Step 4. Select the associate cameras to the event 

 
 
Step 5. Click [OK] to save the setting. 
 

14.3.2. Recording 

Recording 
If an event triggers, recording can record the video content at you selected camera 
with selected recording mode. 
 
Pre-Alarm Recording 
Pre-alarm recording allows to record video before an event trigger. The period of 
pre-alarm recording is at least 1 minute (not more than 2 minutes) before the event 
trigger. You can find that there is at least 1 minute more video content on {Search 
Playback Log} panel before event trigger. 
 
Duration After Event Clear 
After event resets, the recording action will stop after this duration time. 
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Recording Mode 
Event recording provides 2 recording modes, 1 frame per second (1 FPS) and 
continuous mode. In 1 FPS mode, the recording frame rate is less, so the storage 
size is small. In continuous mode, the recording frame rate depends on the number of 
recording camera and more than 1 FPS, so the storage size is larger. 
 
Disk Mode 
Cyclic disk mode can erase the oldest recording data in hard disk if the hard disk is 
full, and continue to record video. Fix disk mode need to stop all recording if hard disk 
is full. 
 
Quality 
This is the quality of the recorded video. The quality is divided into 5 levels (in 
ascending quality order) : low, fair, medium, good and excellent. 
Resolution 
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To set the Recording of a site, follows the steps below 
Step 1. In Option panel of {Site setting} window, click [Recording] under Action 

setting. 
 

 
 
Step 2. The {Recording} window appears. 

 
Step 3. Tick the box of “Enable Recording”. 

 
Step 4. In Recording Extension, set the stop recording 
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Step 5. Select the Recording Mode 
� Continuous: Recording frame rate depends on the number of recording 

camera and more than 1 FPS, storage size is larger. 
� 1 fps: Recording frame rate is less, so the storage size is small. 

 

 
 

Step 6. Select the associate cameras to the event 
 

 
 
Step 7. Click [OK] to save the setting. 
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14.3.3. Switch 

 
Switch allows transmitter to control 4 external relays which are defined by user. 
 
Switch Type  
Switch has 2 types. They are latching or push-button type. In latching type, the switch 
turns on for a period of time. In push-button type, the switch turns on and off after 1 
second. 
 
Latching Duration 
The latch duration period is the time for turning on the switch.  
 
Action Delay 
The delay is the period of time after turning off the switch before next turning on. 
 
Latching Duration and Action Delay Example 
For latch type switch, set latch duration 10sec 
and action delay 10sec. If an event trigger, the 
timing of the switch is shown on the right.                      
Fig 8.2.3a 
 
For push-button type switch, set latch duration 10sec 
and action delay 10sec. If an event trigger, the timing of 
the switch is shown on the right.                              
Fig 8.2.3b 
 
 
To set the Switch of a site, follows the steps below 
 
Step 1. In Option panel of {Site setting} window, click [Switch] under Action setting. 
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Step 2. The {Switch} window appears. 
 

 
 
Step 3. Tick the box of “Enable Switch Control”. 

 
Step 4. In Switch Control, set the Switch to enable. 

 

 
 
Step 5. Click [OK] to save the setting. 
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Action setting of Switch 
To set the overall performance of switches, follow the steps below 
 
Step 1. In Setting Option of {Site setting} window, click [Switch]. 

 

 
 
Step 2. Option panel will jump to [Switch] tab. 

 

 
 
Step 3. Select the Action Delay & Latch Duration 
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14.3.4. Dial back 

 
Dial Back 
Dial back allows the transmitter to connect to one remote PC and displays live video if 
an event triggers. Therefore, remote operator can recognize what situation is at the 
surveillance area.  
 
Retry Duration 
The retry duration is the period between each dial back retrial (in second). 
 
Retry Count 
The retry count is the number of dial back retrial if dial back fails. 
 
To set the Dial back of a site, follow the steps below 
Step 1. In Option panel of {Site setting} window, click [Dial Back] under Action setting. 

 

 
 
Step 2. Select Yes/No to enable/disable the Dial Back. 
 
Action setting of Dial Back 
 
To set the overall performance of Dial Back, follow the steps below 
Step 1. In Setting Option of {Site setting} window, click [Dial Back]. 

 

 
 
Step 2. Option panel will jump to [Dial Back] tab. 
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Step 3. Enter the Dial Back according to their priority 

 
Step 4. Select the Reconnect Duration & Retry Count 

 

 
 
Step 5. If require, do a Dial back Test by [Dialback Test…] button 
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14.3.5. Pan Tile Zoom (PTZ) 

 
PTZ camera action allows the pan tilt zoom camera to go to user preset position for 
viewing what happen if an event trigger. 
 
To set the Pan Tile Zoom of a site, follow the steps below 
 
Step 1. In Option panel of {Site setting} window, click [PTZ] under Action setting. 

 

 
 
Step 2. The {PTZ} window appears. 

 

 
 
Step 3. Tick the box of “Enable Present PTZ”. 

 
Step 4. Select the Recall Present PTZ Camera 
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Step 5. Select the Present No 
 

 
 
Step 6. Click [OK] to save the setting. 
 

14.3.6. Event LED 

The event LED is the LED built on the front panel of TeleEye RX transmitter . If an 
event trigger, the LED is blinking until the event is clear.  
 
To set the event LED of a site follows the steps below 
 
Step 1. In Option panel of {Site setting} window, click [Event LED] under Action 

setting. 
 

 
 
Step 2. Select Yes/No to enable/disable the Event LED. 
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14.3.7. E-mail 

 
To set the E-mail Action of a site, follow the steps below 
 
Step 1. In Option panel of {Site setting} window, click [E-mail] under Action setting. 

 

 
 
Step 2. Select Yes/No to enable/disable the E-mail Action. 
 
Action setting of E-mail 
 
To set the overall performance of E-mail, follow the steps below 
Step 1. In Setting Option of {Site setting} window, click [E-mail]. 
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Step 2. Option panel will jump to [E-mail] tab. 
 

 
 
Step 3. In Server Information, Enter the SMTP Server and the account (if require), 

select the [Timeout] & [Retry Count] 
 

Step 4. In E-mail Accounts, Enter the [E-mail Address] according to their priority 
 

Step 5. Set the [Action Duration] and [Max Number of E-mail]. 
 

 
 
Step 6. If require, do an E-mail Test by [E-mail Test…] button 
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14.3.8. SMS 

 
For some of the RX site, they will have a SMS function for Action 
 
To set the performance of SMS, follow the steps below. 
Step 1. In Setting Option of {Site setting} window, click [SMS]. 

 

 
Step 2. Option panel will jump to [SMS] tab. 

 

 
 
Step 3. Enter the receiver [Phone], [Action Delay] and [Max number of SMS]. 

 
Step 4. If require, do a SMS Test by [SMS Test…] button. 
 

14.3.9. Buzzer 

This buzzer contains inside the TeleEye RX transmitter. It can produce “Beep” sound 
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in order to draw nearby operator attention about an event trigger. 
 
Duration 
Duration is the period for turning on the buzzer. 
 
Action Delay 
Action delay is the period after turning off the buzzer turning on. 
 
To set the Buzzer of a site, follows the steps below 
Step 1. In Option panel of {Site setting} window, click [Buzzer] under Action setting. 

 

 
 
Step 2. Select Yes/No to enable/disable the Buzzer. 
 
Action setting of E-mail 
To set the overall performance of Buzzer, follow the steps below 
Step 1. In Setting Option of {Site setting} window, click [Buzzer]. 

 

 
 
Step 2. Option panel will jump to [Buzzer] tab. 

 
Step 3. Set the [Duration] and [Action Delay] of the Buzzer. 
 

14.4. Siren 

 
The siren can produce a “Don” sound in order to let you know an event trigger. You 
can set duration time for turning on the siren if event trigger. 
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To On/Off the Siren of a site, follows the steps below 

Step 1. In {Live View}, The Siren symbol { } in system status will flashing 
when an event happen 
 

 
 
Step 2. In System status, click the Siren Symbol 

 

 
 

Step 3. The Symbol will back to  when the Siren Off 
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14.5. Global event indicator setting 

 You can setup the global event indicator in the {Global event indicator setting} 

page by clicking the  button. 
 

 
 
Click the [Tick/Cross] button can enable/disable a group of alert sound settings. For 
example, you can disable all the site event alert sound settings by clicking the button. 
[Tick] indicates the option is enabled and [Cross] indicates the option is disabled. 
 

 
 

 
All alert sound of site event is disabled. 

Or you can click the icon to enable/disable one kind of the site event alert sound. 
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Tempering alert sound is disabled 

 
The alert sound of other indicators can also be enable/disable by click its [Tick/Cross] 
button. 
 

 
 Alert sound of low memory is enabled 

 
 

 
Alert sound of low memory is disabled 
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14.6. Event Log 

After connected to the site and finish the event setting, you can check for the event 
status of the site categorize by event type, to check for the status, follow the step 
below. 
 

 
 
To open the {Remote event log} windows, you should select [Remote site] -> [Log] 
-> (one of the Log…according to user requirement) from {Main menu}. 
***4 of the Log will redirect to the same {Remote event log} windows 

 
 
In {Remote event log} windows, 
Panel Name Description 

1 Event tab Categories the event into Tab 
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2 Event record The timeslot, status and event happen under the 
categories 

3 Navigation 
panel 

You can navigate other pages of result, export the log, 
playback and exit 

 

Export the log 

You can select  button to export the log into an excel file 
 

Playback 

Step 1. Select a record from Event record 

Step 2. Then click the [ ] button to start the replay. 
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14.7. Event status 

After connected to the site and finish the event setting, you can check for the event 
status of the site categorize by event type, to check for the status, follow the step 
below. 
 

 
 
To open the {Site event status} windows, you should select [Remote site] -> [Event 
status] from {Main menu}. 
 

 
 
In {Site event status} windows, it shows all the site event status in real time. 
You can also use the drop down manual to select on run event to show. 

All of the event will appear although you clear the selected event by . 
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14.8. Clear event 

To clear event of a site, follows the steps below 

Step 1. In {Live View}, The Event symbol { } in system status will flashing 
when an event happen 
 
 

Step 2. In System status, click the Event Symbol 
 
 

Step 3. The Symbol will back to  when the Event cleared 
 
Also, you can clear the events on the live view screen directly. 
Step 1. When event appear, the event icons will appear on the right hand corner of the 

screen 
 

 
 
Step 2. Click the events icons, the confirmation of delete will prompt. 
Step 3. OK to remove the events. 
 

14.9. Associate camera setting 

Step 1. NX/MX camera associate setting can be set by [Remote site] -> [Site event 
settings…]. 

 
Step 2. Select a NX/MX camera 

 

 
 
 
Step 3. Choose a corresponding event. 
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Step 4. Drag the connection profile or site to display on the spot window when event 

triggered. 
 

 
Step 5. Click [Tick] to apply the setting. 

 

14.10. Event suspension settings 

{Event suspension settings} allow you to stop a specified triggering or triggered 
sensor not to raise any events within a period.  
 
This feature is support by the RX series 
 

14.10.1. Event suspension management 

To manage event suspension time of a video server, you must connect the server 
first.  
 
When the video server is connected, you can select [Remote site] -> [Event 
suspension settings…] from {Main menu} to open the {Event suspension settings} 
window. 
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All triggering or triggered events are listed in the left table {New triggering sensors} 
and all current events settings are listed in the right table {Current sensor 
suspension settings}.  
 
The “Resume time” column shows the end suspension time of the sensor. 

 
 
You can check the triggering or triggered sensor and choose a suspension time in 
{Suspension time} and click [Suspense] to deny the sensor.  
 
When the triggered sensor alarm event is suspended, the alarm will not be noticed 
within that suspension period. 
 

Check [Show all sensors], the list will show all enabled sensors of video server.  

Uncheck it, it will show the triggering sensor only. 

If you want to enable the sensor again, you can remove the sensor from the {Current 
sensor suspension settings}.  

When the suspension period is past, the sensor will be enabled automatically. 
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14.10.2. Event suspension report 

Event suspension report will show all suspension settings of all videos server.  

You can select [Report] -> [Event suspension report...] from {Main menu} to open 
the {Event suspension report} window. 

The enabled suspension period settings are listed in the table. 

 
 
You can click [Refresh] button to reload the data from database. 
 
When the resume time of the suspensions has been reached, the report will clear 
them automatically.  
To view those cleared report, you can check the [Show all records] checkbox to 
show all the suspended sensors. 
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15. System Report 

To open the {System report} windows, you should select [Report] -> [Report…] 
from {Main menu}. 
 
In this section, you will learn the followings: 
 
� Search for site connection log 
� Search for user operation log 
� Search Flow Analysis result and log 
� Backup the log 
 

15.1. Working Environment: 

 

 
 

In {System log} window, 
Panel Name Description 

1 Filter panel It provide constraint to limit the result by day/Type/Sites 

2 Result panel The result will be displayed in this area 

3 Navigation 
panel 

You can navigate other pages of result and exit 
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15.2. Search for site connection log 

To search for a site connection log, follows the steps below 
 
Step 1. Select [Sites] in Type. 
 
Step 2. Select the start date and end date of the log. 
 
Step 3. You can also select the range. 

 
Step 4. Double click a site or click [Show Report] button to show the log 

 
Step 5. Log is displayed on the Result panel. 

 

15.3. Search for user operation log 

To search for a user operation log, follows the steps below 
 
 

Step 1. Select [Users] in Type. 
 

Step 2. Select the start date and end date of the log. 
 

Step 3. You can also select the range of time. 
 

Step 4. Double Click the User or click [Show Report] button to show the log 
 

Step 5. Log is displayed on the Result panel 
 

 

15.4. Search for Flow Analysis report 

To search people counting result and log, follow the steps below 
 
 

Step 1. Select [Flow Analysis] in Type. 
 

Graph: Display In/Out result in chart format. 
Raw data: Display result in raw data format.  

 

• Graph 

Interval: Report graph interval. E.g. if month is selected, the monthly based 
summary will be shown. 
Range: The report time range for result. 
Show: Select In or Out to be displayed in the report. 

 
 
The result of different report interval and range. 
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Report 
range 

Displayed chart 

1 Day 

 
1 
Week 

 
1 
Month 
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12 
Weeks 

 
1 Year 

 
 

• Raw data 

: The report time range for the result. 
Interval: The interval between each record. 
 

 
 

 

 

15.5. Search Video Analytic log 

The video analytic log shows operation log of Flow Analysis, intrusion detection, 
loitering detection and unattended/missing object detection. To show the log report, 
follow the below steps. 

 

Step 1. Select [Video Analytic Log] 
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Step 2. Choose time range 

: The report time range for the result. 
Sort: Report sorting order. 

 
Step 3. Select group, site or camera and click [Show report]. 
 
Step 4. Log is displayed on the Result panel 
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15.6. Backup the log 

For Site and user log: 
 

Step 1. To back up the log, you first need to show the report Result panel.  
 

Step 2. After recall the log, there will be a [Export] button in the Navigation 
panel. 
 

Step 3. Click [Export] to save the log, a {Export log Form} appear. 
 

Step 4. Select the storage path and the page to export then click [Start]. A 
notice with exported file path will be shown when success. 

 
For Flow Analysis report and log: 
 

Step 1. Click [ ] to save the report. 

 
 

Step 2. Input filename and select file type, and then click [Save] button to save 
the report.  

 



sureSIGHT Lite/Business 

16. siteCHECK Report 

16.1. siteCHECK Report 

 
If siteCHECK function is enabled, sureSIGHT will try to connect to the remote servers 
included in the checklist according to the schedule time and the result can be viewed 
through siteCHECK report.  
 

Step 1. To get the siteCHECK report, click  button in {Global event indicator} 
or go to [Report] -> [siteCHECK Report]. 

 

 
 
Step 2. The most updated record is shown on the {siteCHECK Report} form You 

may refer to other records by select a time from siteCHECK report combo box. 
The selections in this combo box are schedule times defined by operators. You 
may choose to see the sites fail to make connection with sureSIGHT instead of 
full siteCHECK result report. The row in red means sureSIGHT could not make a 
connection with this site. The row in yellow means there are siteCHECK 
warnings in this site.  

 
 

If “All Site” option is selected, you will observe some statistics data from “Summary” 
group box.  
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Step 3. You may try to connect to the selected site by clicking [Dial site] button or 
see the detail information about this site by clicking [View site details] button. 

 
Step 4. When there are any siteCHECK warnings or error, operators will observe 

 flashing in {Global event indicator} panel. You may click [Clear Alert] 
button to clear this alert. 

 

Please refer to section 4.4.5 for modification of siteCHECK schedule time and 
checklist. 
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17. sureREC  

sureREC V3 is an recording system running in a personal computer. It works with 
TeleEye NX series, MX series and ONVIF network cameras.  
Besides, sureREC can also wok as a video server. When cameras are added to 
sureREC, the video of these cameras can be streamed to sureSIGHT or other 
software. So the sureSIGHT can view live video through sureREC without connecting 
to these cameras. 
 

sureREC
sureSIGHT

PlayBack

sureREC

PlayBack

Setting

Setting

 
sureSIGHT can connect to multiple sureREC to manage the setting, view live stream 
and playback of recording. 
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17.1. sureREC management 

To open the sureREC setup windows, you should select [sureREC] -> [sureREC 
List…] from {Main menu}. 
 

 
 

 
 
 

In {sureREC setup}, you will be able to make change in 
� Add a sureREC 
� Edit a sureREC 
� Delete a sureREC 
� Edit sureREC settings 
� Update sureREC status  
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17.1.1. Add a sureREC 

Step 1. To add a sureREC into sureREC list, click  . 
 

Step 2. Input required information. Then click  to add sureREC. 
 

 
Step 3. The sureREC is added into the list. 

 
 

** If sureRECs support live streaming, the cameras in these sureRECs will 
be displayed in the site list.  

 
 

You can view the video of sureREC cameras. 
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17.1.2. Edit a sureREC 

 

Step 1. Select a sureREC from sureREC list and click . Or, you can double 
click the sureREC to enter the edit page. 
 

Step 2. Click [ ] to apply the change of settings. 
 

17.1.3. Delete a sureREC 

Step 1. To delete a sureREC, select a sureREC from sureREC list, and click . 
 

 
 

Step 2. Click [Yes] to confirm to delete the selected sureREC. 
 

17.1.4. Edit sureREC settings 

To see the current configurations of the sureREC, you can click  to 

enter the sureREC setting page. 

 

17.1.5. Update sureREC status 

When cameras are added, edited, or deleted in sureREC, sureSIGHT need to 
connect to sureREC to refresh the camera list.  
 

Step 1. Click  in sureREC list to update the camera list of the selected 

sureREC. You can also click  to update all sureRECs.  
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Step 2. Check the status for each sureREC. The following is the meaning of status 
message. 
 

•  Updating: Getting information from sureREC.  

•  Wait: You can start update sureREC. 

•  Cannot connect: Cannot connect to sureREC, you can check the IP and 
port. 

•  Wrong security mode: The security mode is wrong, you can change to 
basic or advanced security mode. 

•  Wrong username or password: The username or password is wrong. 

•  Unknown error: Unknown error. 
 

 
Step 3. The sureREC cameras are updated in site list. 
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17.2. sureREC status monitor 

To open the sureREC status monitor window, you should select [sureREC] -> 
[sureREC status monitor…] from {Main menu}. 

You can also the sureREC status monitor in [Event panel]. By clicking the  
button. 
 
View of sureREC status monitor: 

 
In {sureREC status monitor} window,  

Panel Name Description 

1 Status 
summary panel 

It shows the status summary from sureREC list. 

2 Status panel It shows the status of the selected sureREC. 

3 Camera panel When you select a sureREC site on the left, it shows all 
the cameras added to the selected sureREC. The 
corresponding settings and status of the cameras is 
shown here. 

4 sureREC list 
panel 

It shows all the sureREC sites that you have added to the 
sureREC list. 

 
After adding some cameras to the sureREC, the sureREC status monitor shows the 
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current status and settings of all the cameras of a sureREC. 
 
*** To view the settings, you are needed first click the “Enable sureREC status 
monitoring.” checkbox to enable monitoring.  

 
 

17.2.1. Status of cameras 

In the sureREC status monitor, it shows the current status and settings of all the 
cameras with the associated sureREC. 
 
Example about the status of a sureREC: 

 
 
In the first column of the monitor, it shows the recording status of the cameras. 
 

: The camera is not recorded by the sureREC. 

: The camera is currently recorded by the sureREC. 

: The camera has a schedule recoding, but it is not currently recorded by the 
sureREC. 

: The camera has a schedule recoding and it is currently recorded by the 
sureREC. 
The second column [Site name/IP] shows the site name or the IP of the cameras 
added. 
 
The third column [Status] shows the status of the cameras. 
 
Examples of some camera status: 
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Connected: The camera is connected to the sureREC. 
 
Disconnected: The sureREC cannot connect to the camera. 
 
Rec. stream is used. : The camera is recorded by other sureREC, so it cannot 
perform recoding. 
 
Incorrect user name or password: The password or user name is incorrect and 
sureREC cannot record the video of the camera. 
 
Wrong access mode: Incorrect access mode has been selected. 
 
Invalid reg. Check: The registration code of the connected camera is invalid. 
sureREC cannot record the video of the camera. 
 
Serial no. not match: The serial number of the connect site does not match the 
serial number record in the database of sureREC V3. sureREC cannot record the 
video of the camera. 
 
The fourth column [Setting (fps/size)] shows the settings of the frame rate and size 
setting 
 
The fifth column [Recording (fps/size)] shows the actually recording frame rate and 
the frame size recorded. (It shows only when the camera is currently recorded by the 
sureREC). 
 
If any of the fields have any errors, the fields will be highlighted in red. 
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17.2.2. Status of sureREC sites 

sureREC status monitor gets the status of all sureRECs added to the sureREC list 
from time to time. 
 
The status of the sureRECs is shown on the left side of the sureREC status monitor. 
 
If a camera has some errors, the associated sureREC site will show some warning on 
the sureREC status monitors. 
 

 
 
The sureREC site itself can cause errors. For example, if the sureREC site does not 
have any hard disk partition added, a warning description will be shown: 
 

 
 
There are three status of sureREC: 

: It means the sureREC site is running fine, all the cameras of that sureREC has no 
error. 

: It means the sureREC site is running, but there are some errors with the cameras. 

: It means the sureREC cannot be connected. No information can be shown. 
 
The status sign is based on the status of the corresponding sureREC site. 
 

17.2.3. Global status of sureRECs 

The global status will be shown on the top left corner of the {sureREC status 
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monitor} form. 
 

 
 
There are three warning signs to indicate the status: 

: It means some all the sureREC sites are running fine. 

: It means some of the sureREC sites have errors. 

: It means some of the sureREC sites cannot be connected. 

The warning signs have the priority with:  >  > . 
 

For example: In the figure below, the summary status shows , because it has 

a higher priority than . 
 
Example on status summary: 

 
 

17.2.4. Try to solve the errors 

When there are errors in a sureREC site, a  will be shown on the status of that 
site. 
You can click the button to try to solve the errors. 
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For , which means there are errors with the cameras, the  will link user to 
the sureREC setting page to edit the cameras. 
 

For , which means the sureREC site was disconnected, the  will link user 
to the sureREC List page to edit the connection settings. 
 

Location of the  button: 

 
 
For the hard disk partition error, you should go to the sureREC site PC to add a 
hard disk partition for recording. 
 
Step 1: Open the {sureREC} main panel. 
Step 2: In the {Hard Disk Setting} window, click [Add] button to add partition. 
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Step 3: In the {Add Hard Disk Partition} window, select the hard disk for recording 
and the size of the partition. 
 

 
 
Step 4: Click [Ok] to save the settings, and click [Ok]. In the {Hard Disk Setting} 
window to finish. 
 



sureSIGHT Lite/Business 

17.3. PlayBack from sureREC 

Step 1. You first needed to add a sureREC site. Go to sureSIGHT, select [sureREC] 
-> [sureREC List…] from {Main menu}. 
 

Step 2. After adding a sureREC site, click  to finish. 
 

 
 

Step 3. In {Main page} of sureSIGHT, click . In the playback list, the sureREC 
we added already will appear. You can double click it to run the playback. Also, 
all the NX/MX sites that we added will be shown on the playback list. 
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Step 4.  The recording slot appear in the {main frame} 
 

 
 

Step 5. Select the recording timeslot and then click button 
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Step 6. The playback will be started.  
 

 
Step 7. ***You can use the scrollbar at the bottom to adjust the navigation of 

playback. 

Step 8. You can click the  button in the {Playback control} frame to stop 
the playback. 
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17.4. Backup Video from sureREC 

To extract and backup the video from sureREC, in the [Playback] panel 
 
Step 1. Choose the sureREC 

 
Step 2. In the timeslot, right click and select [Extract the video…] 

 

 
 

Step 3. The [Remote footage extraction] windows appear 
 
Extract To: Specify a folder to store the data. Click [Browse…] to choose a path. 
 

 
 
Mode: Select mode for footage extraction. 
 

 
Start Date/Time: Select the start date/time. 
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Step 4. Click [Recording Start Time] to select start time of the recording log. 

Click [Current Hour] to select current hour of the server. 
 

End Date/Time: Specified by period length or memory size of the video data to be 
extracted. 
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Step 5. Click [Start extraction] to start the video backup process. A confirmation 
message will be popped up.  
 

 
 
Step 6. If the information is correct, click “OK” to start the extraction. 
 

 
 
Step 7. Click [Confirm] to add description of the video backup using a text file. 

Click [Cancel] to cancel extraction. 
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Video backup completed. 
Clicking [Yes] can go to the backup directory. 
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17.5. sureREC settings page 

To open the {sureREC settings} window, you should select [sureREC] -> [sureREC 
settings…] from {Main menu}. 
 
When a camera is recorded by a sureREC site, the screen of it will have a red “REC” 
button 

. You can click on this button to open the {sureREC settings} window. 
 In the {sureREC settings} window, it allows you to perform the following functions: 
They will be discussed in the following chapters. 
 
*To edit the recording settings of cameras. 
*To create schedule template for schedule recording. 
*To view the resource being used in a particular sureREC sites. 
 

17.5.1. sureREC schedule template setting 

sureREC schedule setting can be save as a template and apply to cameras through 
schedule template function. 
 

 

Click [new] button to add a new sureREC recording schedule template. 
 

 
 

For the new recording schedule template, you can define its name and template type. 
User can also add a description for this template. 
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Click [Next>>] to next step. 
 
New schedule template 
 

 
 
In {sureREC schedule recording template settings} window,  

Panel Name Description 

1 Schedule template 
panel 

It shows the week schedule GUI of schedule 
recording template. 

2 Schedule template 
function panel 

It shows the alter function of schedule recording 
template. 

3 Advance setting 
panel 

It shows the setting when event triggering or motion 
event triggering. 

 

Add schedule to recording schedule template 

 
 
Click [add] or drag a time period from the bar of {schedule template panel} to enter 
{add a sureREC schedule recording template record} page. 
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Start time and end time: The time period of the schedule record. 
Weekday: The day(s) will run the schedules. 
 
Recording type:   

Normal – recording during the recording period. 
On Event Only – recording when there are any events triggering during the 
recording period. The recording will be stop after the “recording extension time”  
On Mix – You can set different frame rate for “Normal” recording and “On event” 
recording. For example, you may set “1 fps” for “Normal” recording to reduce the 
normal recording size, and set “25 fps” for “On event” recording to recording more 
evidence. 
 

The color of schedule record is according to the recording type.  
Red color is for “Normal” recording.  
Green color is for “On event only” recording. 
Blue color is for the “Mix” recording. 

 
Recording frame size: The resolution of recording frame. 
Recording frame rate: The frame rate of recording. 
If user choose [On event only] or [Mix] recording type. The “On event” recording 
setting is enabled. 

 

On all events: Check [On All Event] to apply “On event” recording settings when 
any events is triggering. 
On motion event: Check [On Motion Event] to apply “On event” recording setting 
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when motion event is triggering only. 
Click [setting] to set up the “On event” recording setting. 
 

 
 

Frame rate: the recording frame rate will be applied when “On event” recording 
setting applied. 
Recording extension: the duration of “On event” recording after the event reset. 
 
You fill all the suitable information and click [OK] to add the new schedule recording 
schedule. 

 
 
When adding the schedule recording successfully, a color bar will be shown on the 
scheduler to represent the schedule record. 

Edit schedule template record 
 
Select a {Schedule template record} or double click it to edit the record. The {Edit a 
sureREC schedule recording template record} will be shown. You can update any 
information of the recording.  

In the Figure 16-1, the schedule is set to run on Monday only. If changing the 
recording day of the schedule to both Monday and Tuesday, the scheduler will 
show two bars to represent the schedule record.  
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Figure 17-1 update weekday of schedule recording record 

 
Figure 17-2 result of update 

 
 

Delete schedule template record  
 
Select a schedule template record and click [delete] button. The selected schedule 
recording will be removed. 
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Advanced recording setting 
 
You can set recording frame rate and extension time at {Advanced recoding setting} 
page. The setting will be applied when there was event(s) triggering 
 

 
Figure 17-3 advance recording settings 

 
Click [Setting…] to enter the setting page. 
 

 
 
You can set the recording frame rate and the duration of recording when an event 
trigger. Click [Save] to finish the setting. 
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17.5.2. To add a manual recording 

To add a recording, you can drag the cameras from the [unassigned camera panel] 
to any sureREC sites that you want to the [sureREC List panel]. 
 
Step 1. Choose a sureREC. In this example, “local2” is selected. 

Then the camera will appear in the [Manual recording panel] with default 
recording settings. 

For MX camera, the default setting is: Auto frame rate with HD frame size. 
For NX camera, the default setting is : Auto frame rate with Full frame size. 
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Step 2. To edit the recording settings, you can double click the camera column. 
 

 
 

You can edit the frame size and frame rate manually. The corresponding 
required resources will be shown on this window too. 
 

Step 3. After complete the configuration, click the [Save] button. 
 

Step 4. Click the [Apply] button on the right bottom of the {sureREC settings} 
window. 

A message “Settings saved” will be shown to indicate successful configuration. 
 

17.5.3. To add a schedule recording 
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Step 1. To add a recording schedule, you can drag the existed schedule templates 

from the [Schedule Template panel] to the column of the camera. 
 
 

The [Schedule] field will show the name of the schedule template. 
 

 
 
You can also assign a custom schedule for the camera by double-clicking the entry of 
{schedule recording panel}. Please refer to section 17.5.1 for the details on how to 
manage schedule template. 
 
Upon configuration of the schedule, the name shown in the [Schedule] field becomes 
“Custom”. 
After editing the schedule, the corresponding resources used will be updated 
automatically. 
Step 3: Click the [Apply] button on the right bottom of the {sureREC settings} 
window. 
A message “Settings saved” will be shown to indicate successful configuration. 
 
Note: 
*You can manage the schedule template in the [Schedule Template Panel], by using 
the [New], [Edit] and [Del] buttons. 
The detailed operation on schedule template has been discussed at the [sureREC 
recording configuration wizard] chapter. 
 
*For a schedule recording, a schedule must be attached with it in order to have 
successful configuration. 
 
 

17.5.4. To manipulate camera recordings 

{sureREC settings} window allows you to perform camera functions in a convenient 
way. 
 
For example, you can set a camera to be recorded by another sureREC site simply by 
dragging the camera in the [sureREC List panel]. 
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Then click the [Apply] button to save the changes. 
 
Similarly, if you want to change the recording type of a camera, you can drag the 
camera to the [Schedule Recording panel] of the desired [sureREC site panel]. 
 

 
 
You can perform as many camera functions as they want. Then click the [Apply] 
button to save all the changes. 
 
If a camera is not added to your site list, it will be appeared in the recording panels 
with a “*” in front of its name. 
 
You can also perform camera functions to this kind of cameras. 
 
For Manual recording: 
MX camera will have Auto frame rate with HD frame size. 
NX camera will have Auto frame rate with Full frame size. 
 
For Schedule recording: 
All the cameras will have empty schedule.  
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18. Backup 

In this section, you will learn the followings: 
� System settings backup 

� Export 
� Import 

� Full database backup 
� Export 
� Import 

� Save picture 
� Video backup 
 

18.1. System settings backup 

System settings backup function allows you to backup sites, user accounts, 
connection profiles and sitemap information when performing system upgrade, 
migration or maintenances. 
 

18.1.1. Export 

Select [System] -> [System backup] -> [Settings import and export] -> [Export…] 
from the menu bar. 
 

 
  
 
The following window is displayed. 
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To export the information, click [Export] button. Choose the path and file name for 
export. Click [Save] button to export the information to the Excel file. 
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18.1.2. Import 

Select [System] -> [System backup] -> [Settings import and export] -> [Import…] 
from the menu bar. 
 

 
 

1. To import sureSIGHT backup setting files, select [ ]. 

 

Then click [ ] button to select folder that contains backup information. Click 
[Import] button to import the information. 
 
2. To import sites from WX-30 database, select 

[ ]. 
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Step 1. Click [ ] to select WX-30 database folder. Then click [Import] button to 
import WX-30 sites. 
 
Step 2. A table of sites that failed to import will be shown. 

 

 
 

Step 3. Click [Export] to save the failed site table (if required). 
 
Step 4. WX-30 sites with group name WX30Imported will be imported to the Site List. 
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18.2. Full database backup 

Full database backup function allows you to backup sites, user accounts, connection 
profiles and sitemap information when performing system upgrade, migration or 
maintenances.  
 

18.2.1. Export 

Select [System] -> [System backup] -> [Full database import and export] -> 
[Export…] from the menu bar. 
 

 
  

The following window is displayed. 
 

 
  

To export the information, choose the path and file name for export. Click the [Export] 
button. 
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A notice dialog box with the path of backup file will appear. 
 

18.2.2. Import 

***All settings in the sureSIGHT will be removed when imported 
Select [System] -> [System backup] -> [Full database import and export] -> 
[Export…] from the menu bar. 
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The following window is displayed. 
 

 

To import the information, click the [ ] button to select the folder that store the 
backup information on [Import (Restart system is required)] button to import the 
information. 
 

 
 
A warning dialog box will appear, [Yes] to continuous the Database import, all data in 
current database will be deleted, [No] to terminate the backup. 
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18.3. Camera reference image 

18.3.1. Adding a New Camera Reference Image  

To add a new camera reference image to a site, follow the steps below: 
 
Step 1. There are 2 methods to add camera images. 
 
Method 1: 
 
Connect to a site and right click at a camera, choose [Camera Image] -> [Save 
reference image to database] to save a camera reference image. 
 

 
 
Method 2:  
 
If one or more images have been saved, you can add new images by image viewer. 
Connect to a site and right click at a camera, choose [Reference picture] -> [View 
image from database] 
. 
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Then Click [Add Image] button 
 
Step 2. A form to save camera image is displayed. 

 

 
 
Step 3.  Select camera, image types and input remark 

Cam: Image for normal camera view 
Preset: Image for preset camera view 
Day: Image in daytime 
Night: Image in nighttime 

 
Step 4. Click [Browse...] to choose the image for this camera.  

 
For step 1 method 2, the default image is automatically loaded to this form, so 
you can skip this step by using the default image. 
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Step 5. Click [Save] button to save the image.  

 

18.3.2. Editing or Delete an Existing Image 

To update camera reference image, follow the steps below: 
 
 
Step 1. Connect to a site and right click at a camera, choose [Camera image] -> 

[View image from database] to view camera reference images. 
 
Step 2. You can edit or delete the images in the viewer. 

1. Edit image:  Click [ ] button to enter a edit form. 
 

 
 
Then, click [Browse...] button to load new image and click [Save] button to save the 
changes. 
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2. Delete image: Click [ ] button to delete the image. 
 

18.3.3. Save live and playback Image to PC 

To capture viewing camera reference image and save the image to PC, follow the 
steps below: 
 
Step 1. Connect to a site to view live or playback video. Then right click at a video 
screen, choose [Camera image] -> [Save image to PC] to save an image for this 
camera.  
 

 
Then an image viewer is displayed, you can view and save the captured image. 
 

 
 

Step 2. Click [ ] button to save the image. 
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18.4. Video backup 

There are 4 ways to enter the {footage extraction} window to record video. 
 
 
Method 1: Select [Extract video…] in the right-click menu of a video window. 
 

 
 
Method 2: Select [backup the video…] in the right-click menu of a bookmark. The 
video backup start time will be pre-defined to the time of bookmark. 
 

 



sureSIGHT Lite/Business 

Method 3 (Only on GX/RX): Select [Extract the video…] in the right-click menu of 
recording log. The video backup start time will be set to user selected time in 
recording log. 

 
 

Method 4: Click [ ] button in the playback log. 
 
 

  
 
 
{Footage extraction} shown. 
 
For RX/GX: 
 
Remote Server Recording Information: Shows the information of the video data. 
Such as the available period of time, the space of hard disk in the video server. 
 
Extract To: Specify a folder to store the data. Click [Browse…] to choose a path. 

 
 
Camera: Select the cameras to be extracted video from. 

 
 
Mode: Select mode for footage extraction. 

 
Start Date/Time: Select the start date/time. 
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Click [Recording Start Time] to select start time of the recording log. 
Click [Current Hour] to select current hour of the server. 
 
End Date/Time: Specified by period length or memory size of the video data to be 
extracted. 

  
Step 6: Click Start extraction to start the video backup process. A confirmation 
message will be popped up.  

 
If the information is correct, click [OK] to start the extraction. 
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� Click [Confirm] to add description of the video backup using a text file. 
� Click [Cancel] to cancel extraction. 
 

 
Video backup completed. 
� Clicking [Yes] can go to the backup directory. 
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For JN/VN: 
Step 1: Specify the search criteria. 
 

Backup To: Specify a folder to store the data. Click [ ] to choose a path. 

 
 
Search start: Specify a date and time as the start time period of the extraction. 

Input a start time and click [ ] to choose a date. 

 
  
Search end: Specify a date and time as the end time period of the extraction. Input 

an end time and click [ ] to choose a date. 
 
Camera: Select the cameras to be extracted video from. 
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Step 2: Click [Search] to start the video backup process. 
 
Step 3: Select the videos to be extracted in the recording list and click [Add to 
extraction list] button. 

  
 
Step 4: Click [Start extraction] to initiate the footage extraction. 

 
 

Step 5: Click [Open] to watch the video when the extraction process is completed. 
 
Step 6: Video backup completed. 
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19. Audio control 

Audio control can receive audio from the remote site. This control also supports 
pre-recorded voice files for playing to the remote site. 
 

19.1. Working environment 

 
 
Audio Enable  
Click the [On/OFF] button to enable the {Audio Reception} function. 
 

 
 
You can select a connected site to accept the audio. 
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Audio Reception 
You can select the audio channel, and control the speaker volume through enabling 
the speaker function 
 

  
 

You can set audio to mute through [ ] button. 
 

 
 
Public Address (P.A.) and Pre-recording voice file setting 
 

Step 1. Click [  page to set P.A. function. 
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***If you want to play pre-recorded voice, please go to step 2. Otherwise please go to 
step 6.  
 

Step 2. Click [ ] button to add voice sources. 
 

 
 

Step 3. Click [ ] icon in Pre-recorded audio settings window. 
 
 
Step 4. Select a wav file and click [Open] button. 
*** The wav file must be {16bit mono PCM} format 
 
Step 5. Input name for the voice file 
 

 
 
Step 6. Choose an audio source file from the dropdown list. You can start P.A by mic if 
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choosing Mic. Besides, you can play pre-recorded voice by choosing file that added in 
previous steps. 

 
 

Step 7. Click [ ] button to start P.A. Click this button again to 
end P.A. 
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20. Dial back 

Enable dial back standby 
Step 1. Click [System] -> [Dialback standby] button on the {Main menu}. 
 

 
Step 2. You need to specify a stand by port for the dial back function. The default 

port number is 2048. 
 

 
 
Step 3. Click [Tick] to apply the setting. And the [Dialback standby] button will be 

set down. It represents the dial back function stand by.  
 
Step 4. For the dial back event of the server site, please refer to the event 

management. 
 
Dial back indication 
When an event triggers a dial back, the site will be listed in the {Connection Status} 
dialog box with a red color highlight record. The triggered video will be displayed at a 
spot window. You also can double the triggered record to playback its video. 

 
 
(Remark: The dial back function can support up to 4 dial back event at the same 
time.) 
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21. Spot Window 

Spot window allows triggered video display on a spot window.  
 
Working Environment: 
Step 1. Click [View] -> [Spot windows] button on the {Main menu}. 

 

 
 
Step 2. [Show spot windows each time when event is triggered.] Options allow 

you to enable the spot window popup function when event triggered. 
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22. Video comment 

Video comment allows you to input comment for the live or playback video. The video 
comment can be used as keywords to search playback video and it will be displayed 
on the video during video playback. 
 

22.1. Add Preset video comment 

Preset comment allows you to save 6 commonly used video comments.  
 
To add preset video comments, follow the steps below. 
 
Step 1. Click [Value-added Module] -> [Video comment history…] button on the 

{Main menu}. 

Step 2.  Input preset comment and the click  to save the result. 
 

 
 

22.2. Input video comment 

To add video comment to the video, follow the step below. 

Step 1. If the site is currently recording in sureREC,  button will display in live or 
playback video. 

Step 2. Click  button. A panel to input video comment will be shown. 
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Step 3. Three methods to Input comment. 

 
1. Input text in the space 
 

2. Click  to load preset comment  
 

3. Click  to load recently inputted comment. 
 

Step 4. Click [Save] to save the video comment. 
 

 

22.3. Search playback video by video comment 

You can search the playback video by video comment. 
 
Step 1. Two methods to search video comment and playback  
 
Method 1: Right click on video and click [Search data…]. 
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Method 2: Go to playback mode, Select a camera and click [ ] button. 
 

Step 2. A panel to search video comment will be shown.  
 

 
Remark: no keyword inputted means to search all video comments. 
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Step 3. Input search criteria and click [Search] button to search the result.  

 
The recorded video with video comment will be indicated with  in video 
recording bar. 

 

 
 

Step 4. Click [Click to playback] to start video playback at corresponding time. 
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23. Flow Analysis 

Please refer to “Flow Analysis Setup Guide for Indoor Environment” for camera and 
sureSIGHT setup procedure. 

 

 

24. Video Analytic 

Video analytic includes three types of function, Intrusion, loitering and 
missing/unattended object detection. When event occur, it can alert to the local 
sureSIGHT user, and also soft-trigger the video server’s alarm to alert other remote 
users. 

 

 

24.1. Setup Video Analytic detection 

The three detections is set independently, and maximum three regions can be setup 
each. 
 

24.1.1. Intrusion detection 

To add intrusion detection, follow the steps below. 
 
Step 1. Click [Value-added Module] -> [Intrusion detection…] button on the 

{Main menu} 
 

Step 2. Click “Setup Intrusion detection”  button to add a camera. 
 

Step 3. Choose a camera from the camera list. 
 
Step 4. In the video area, you can add maximum of three intrusion regions. Position, 

shape and size can be adjust for each region. Pause video button  may be 
helpful in some situation for placing the detection regions. 
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Step 5. In the event action setting, external alarm trigger can be set in order to soft 

trigger the video server when detection event occurred. Assign one free alarm 
number in the combo box. 

 

 
 
 
Step 6. Click “Finish” button to apply the setup. 
 
 

24.1.2. Loitering detection 

To add loitering detection, follow the steps below. 
 
Step 1. Click [Value-added Module] -> [Loitering detection…] button on the 

{Main menu} 
 

Step 2. Click “Setup Intrusion detection”  button to add a camera. 
 

Step 3. Choose a camera from the camera list. 
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Step 4. In the video area, you can add maximum of three intrusion regions. Position, 

shape and size can be adjust for each region. Pause video button  may be 
helpful in some situation for placing the detection regions. 

 
Step 5. In the event action setting, external alarm trigger can be set in order to soft 

trigger the video server when detection event occurred. Assign one free alarm 
number in the combo box. 

 
Step 6. Click “Finish” button to apply the setup. 
 

24.1.3. Unattended/Missing object detection 

To add unattended/missing object detection, follow the steps below. 
 
Step 1. Click [Value-added Module] -> [unattended/missing object…] button on 

the {Main menu} 
 

Step 2. Click “Setup Unattended/missing object detection”  button to add a 
camera. 
 

Step 3. Choose a camera from the camera list. 
 
Step 4. In the video area, you can add maximum of three intrusion regions. Position, 

shape and size can be adjust for each region. Pause video button  may be 
helpful in some situation for placing the detection regions. 

 
Step 5. In the event action setting, external alarm trigger can be set in order to soft 

trigger the video server when detection event occurred. Assign one free alarm 
number in the combo box. 

 
Step 6. Click “Finish” button to apply the setup. 
 
 

24.1.4. Advanced Setting – Object filtering 

To minimize the chance of false alarm, object filtering is used to filter out 
non-interested object which could triggered false alarm. Object filtering can be apply 
to intrusion, loitering and unattended/missing object detection. Follow the below step 
to enable object filtering. 
 

Step 1. At the intrusion detection setup screen, for example, click on the  
“Advanced Setting” button. 
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Step 2. Select “enable” to start object filtering and then click “Next” button. 
 

 
 
 
Step 3. The first step of enabling object filtering is to do calibration by entering the 

camera install orientation and property.  
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Camera properties: 
Property Description 
Height (m) Distance between camera and the floor in 

meter. 

 
Tilt (degree) Camera tilt angle from horizontal. 

 
 

Roll (degree) Camera roll angle from horizontal. 

 
FOV (degree) Field of view (FOV) angle of the camera. 
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Step 4. To see if the camera properties match the environment, place the onscreen 

overlaid ruler near a real person on screen. The properties are fine if the height of 
a person is similar to that of the ruler. You are advised to measure several 
different positions on screen to ensure the correctness. When calibration is done, 
click “Next” button. 

 

 
 
Step 5. Object classification page. Four types of object is included by default for 

classification. The default value work on most situation, or you may adjust the 
value if needed. Select type of object you want to include or exclude for the 
analytic. 

 

 
 
Step 6. Click “Done” to finish the setup. 
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24.2. Video Analytic event 

When Video Analytic detection is enabled on a camera, the analytic information is 
shown on live screen. 
 

 
 
 
 
In the Events panel, video analytic icon is shown triggered when any of the analytic 
event occurred. 
 

 
 
 

Icon Description 

 

Normal 

Detection 

Region 

Triggered 

Object in 

Red 

Object 

track 

Alarm 

associated 
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Triggering 

 

Triggered 

 
To see the detail of occurring event, click on the analytic event icon to show the list. 
 

 
 

There are two types of event, the analytic event (intrusion, loitering and 
unattended/missing object detection) which located at the upper list of the event 
dialog. And engine event that include any connection problem, low frame rate warning 
and so on.
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Trouble shooting 

This section lists some common Frequently Asked Questions and Troubleshooting 
problems along with suggested causes and solutions. 

24.3. Q & A 

Problem 1.  
I am trying to connect to the server using the software through the TCP/IP 
network, but the connection cannot be established and there is no video updated 
on the software. 

Solution: 
� Make sure TeleEye Remote Server is powered on. 
� Make sure the server and your PC are connected to the network. Make sure 

the IP Address and port number are correct. 
� Make sure the port is not blocked by any firewall. 

 
Problem 2.  

The camera can be connected, but there is no video. 
Solution: 

� Make sure the video source is correctly connected to the server.  
� Check whether the camera is enabled. Refer to remote server setting. 
� Make sure DirectX version 9.0c or above has been installed in your 

computer and Direct 3D acceleration is enabled. To check whether Direct 3D 
acceleration is enabled or not, go to [Start] ->start cmd.exe->enter “dxdiag”, 
{DirectX Diagnostic Tool} dialog box will display. 
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Click [Display] tab and make sure the Direct3D Acceleration is enabled. 

 
Try to install the latest version of display card driver and Direct X. 

 
Problem 3.  

How can I go back to sureREC V3 main windows form when I am in full screen 
mode? 
Solution: 
� Click [Esc] button to go back to video viewer windows form 
 
 
 
Problem 4.  

I cannot import a file to the system 
Solution: 
� Make sure you do not change the format of the import file 
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� Make sure the camera you want to import into the system does not have the 
same name or serial number as any camera that already exists.  

� Make sure the registration code is correct. 
 
Problem 5.  

I have installed microphone at PC, but cannot perform Public Addressing. 
Solution: 
� Try to P.A .with a pre-recorded wave file, if it is successful: 
� Check carefully whether the microphone is plugged into the correct jack and is 

turned on. 
� Make sure the microphone input is enabled in Windows [Control Panel] -> 

[Sound] -> [Recording] 
� Try to increase the sound level and use the boost [Control Panel] -> [Sound] -> 

[Recording] -> [microphone] -> [Properties] 
� Try to restart the Video Viewer 
� If pre-recorded wave file also cannot be played: 
� Check whether the speaker is connected to the server correctly 
� Make sure the speaker has been powered on 
 
Problem 6.  

Audio Reception does not work. 
Solution: 
� Make sure the [Audio] button is clicked on, correct channel is selected and it is 

not muted in Audio Reception panel 
� Check whether the microphone is supported by the server (amplifier may be 

needed) 
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24.4. Generate support files 

If critical problem happened, sureSIGHT provides a [Generate support files] 
function for you to generate an error report for further supporting help. 
 
You can access this function from [Help]->[Generate support files...] 
 

 
  

 
 

Clicking [generate support file] button and choose a path to store the file. 

  

 
Waiting for the files generation completed, finally a message box will show the file 
path. 

 
 

24.5. TeleEye remote support 

TeleEye remote support use remote desktop control technology to support client 
users. Our technicians will control your computer remotely to realize the problem.  
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If you have critical problem of sureSIGHT, you may contact our support team. You can 
also dump the screen of {TeleEye remote support}, and send it to our support team by 
email support@TeleEye.com. 
 
Select [Help] -> [TeleEye Remote supporting…] to go to TeleEye remote support 
page. 
 

  
 

Dump the screen below: 
 

 
Figure 24-1 screen dump of TeleEye remote support 

 
 

25. Appendix 

In this section, you will learn the followings: 
� sureLINK technology 
� Transmitter Modification 
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� TeleEye Rx with tamper circuit and External Resistor 
� Security mode 
� Shortcut keys 
 

25.1. sureLINK technology 

sureLINK technology is available in TeleEye RX, which enables you to connect to the 
transmitter with broadband dynamic IP Internet connection. If you can only use 
broadband dial-up account to connect to the Internet through your computer, 
sureLINK provides a solution for sharing the Internet connection between your 
computer and the transmitter. 
 
sureLINK is a group of additional functions, services and software provided for the 
transmitter so as to make it to connect to the Internet in any connection methods. 
Such function can only be used if you have applied for this service. After you have 
done so, you also need to configure the transmitter to make sureLINK available. This 
section will help you to configure and use it. 
 
By using of sureLINK technology, the powerful TeleEye RX can work on broadband 
Internet economically, a cost effective and convenient remote live video monitoring 
anytime and anywhere.  
 

� sureLINK Address 
You can apply for a sureLINK address (domain name), such as 
www.hkpublic.teleeye.teleeye.net, for your transmitter.  You can use this name 
to login or browse the built-in web server **. One of the advantages is that you are 
not required to memorize the IP address (e.g. 210.177.50.156) of the transmitter. 
Since the sureLINK address is fixed while the IP address may change 
periodically (in case when dynamic IP is used), you do not need to worry about 
the expiration of the IP address. The sureLINK address can also be used in 
transmitter web browsing to see live video on standard web browser (e.g. IE, 
Netscape). 
 

� Refreshing Rate 
When sureLINK address feature is enabled, the transmitter will periodically 
update its current IP address to our database to ensure that the sureLINK 
address is always forwarded to a valid IP. You can set this update period 
through OSD menu. 
 

� DNS Services: 
Assigned when the transmitter can directly access the Internet without the 
help of TeleEye Proxy Server 

** : This function will be supported in TeleEye RX transmitter version 2.00.00 or later 

How to apply for sureLINK Address 

You can apply for sureLINK by visiting our web site at http://www.TeleEye.com 
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Step 1. Click [Customer Login] 

 

 
Step 2. Sign up to create your user account 

 
Step 3. Login the page using your registered name and password. 

 
Step 4. Click sureLINK Address Registration button 
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Step 5. Sign up with the user account 

 
 

Step 6. Enter a sureLINK address (Domain Name), your Transmitter Serial No. 
and Registration Code in the fields provided respectively. Then click the Apply 
button. The process is then completed. 

 

After we received your domain name registration for your transmitter, your application 
will be processed. Normally, it requires about 1 working day to activate sureLINK for 
your transmitter. You will receive a notification mail when your sureLINK service is 
ready. 
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25.2. Transmitter Modification 

Since the sureLINK (Domain name) address corresponds to a single transmitter, if 
you change from one transmitter to another one, you have to inform us to update our 
database record. To do this, you can visit our TeleEye Product Support again and 
follow the steps below: 

Step 1: Transmitter Modification > Select a sureLINK address (Domain Name) 
you want to modify  

 

 

Step 2:  Enter the Old Registration Code, New Transmitter Serial Number and 
New Registration Code at each field provided. Click [Modify] button to 
submit the form. 

 

If the above procedure is completed successfully, the sureLINK will be effective 
immediately.

25.3. TeleEye RX with Tamper Circuit and External 



TeleEye RX with Tamper Circuit and External Resistor 
 

Resistor 

 

TeleEye RX supports tamper detection (DEOL and SEOL) on all alarm inputs, 

arm/disarm input, security switch input, system tamper and power failure input. 

 

DEOL : Dual End of Line termination with NC and NO connection 

SEOL : Single End of Line termination with NC and NO connection 

NC/NO : Alarm and other input ports without tamper detection circuit connection 

 

 For example, by connecting the tamper circuit with DEOL, the circuit with the normal closed condition if the resistance 

between point A and B detect 1.2kΩ (shown as below), or the circuit with the normal open condition if the resistance between 

point A and B (shown as below) detect 7.2kΩ.The resistance transition from 1.2kΩ to 7.2kΩ is generated an alarm tamper event 

for normal close circuit. The setup configuration of those alarms and input ports are shown in the following diagram. The circuit 

denouncing time between each sensor is 20 millisecond. 

 

Dual End of Line Configuration 

 

  

Normal Close (NC) 

 

 

 

 
Normal Open (NO) 

 

 

 

Single End of Line Configuration 

 

Term Status Description 

S/C TAMPER Wire short (point A and B) 

LoZ NORMAL Sensor drive output close (point B and 

C) 

HiZ ALARM Sensor drive output open (point B and 

C) 

O/C TAMPER Wire open (point A and B) 

Term Status Description 

S/C TAMPER Wire short (point A and B) 

LoZ ALARM Sensor drive output close (point B and 

C) 

HiZ NORMAL Sensor drive output open (point B and 

C) 

O/C TAMPER Wire open (point A and B) 

wire sensor 

drive 

A 

B 

C 

sensor 

drive 

output B 

A 

wire 

C 

wire 
sensor 

drive 

output 

A 

B 

C 

R1.2K 

 

R1.2K 
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Normal Close (NC) 

 

            

            

                       

                                     

Normal Open (NO) 

 

Without Tamper Detection Circuit Configuration 

 

 

 

 

 

Normal Close (NC) 

 

 

 

 

 

 

 

Normal Open (NO) 

 

 

 

LEGEND 

NO Normally Open Alarm 

NC Normally Closed Alarm 

O/C Open Circuit 

Term Status Description 

S/C TAMPER Wire short (point A and B) 

LoZ NORMAL Sensor drive output close (point 

B and C) 

O/C ALARM Sensor drive output open (point 

B and C) 

Term Status Description 

S/C ALARM Sensor drive output close (point 

A and B) 

LoZ NORMAL Sensor drive output open (point 

A and B) 

O/C TAMPER Wire open (point A and B) 

Term Status Description 

S/C  NORMAL Sensor drive output close (point 

A and B) 

O/C ALARM Sensor drive output open (point 

A and B) 

Term Status Description 

S/C  ALARM Sensor drive output close (point 

A and B) 

O/C NORMAL Sensor drive output open (point 

A and B) 

sensor 

drive 

output 

A 

B 

wire 

sensor 

drive 

output 

wire 

A

B 

sensor 

drive 

output 

wire 

B 

A 
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S/C Short Circuit 

LoZ Low Impedance 

HiZ High Impedance 

 

 

The below table shows the summary between the resistance network and the 

condition result. Note that this table is used as a reference. There may be a 10% 

tolerance for the resistance value in the below table. 

 

Resistance (Ω) 

Condition 0~400 401~2780 2781~29.5k 29.5k~Infinity 

DEOL (Normal Close) Tamper Short  Normal (Close) Alarm (Open) Tamper Open 

DEOL (Normal Open) Tamper Short  Alarm (Close) Normal (Open) Tamper Open  

SEOL (Normal Close) Tamper Short  Normal (Close) Alarm (N/A) Alarm (Open) 

SEOL (Normal Open) Alarm (Close) Normal (Open) Alarm (N/A) Tamper Open 

NC without tamper Normal (Close) Alarm (N/A) Alarm (N/A) Alarm (Open) 

NO without tamper Alarm (Close) Alarm (N/A) Alarm (N/A) Normal (Open) 

 

Alarm (N/A): Alarm with not applicable.  

 

25.4. Security mode 

On RX360 series, there are 2 security modes: BASIC and ADVANCED security 

mode. 

 

Basic security mode 

- 2 user accounts (Administrator and normal user. User account can only be 

applied to remote software) 

- 2 access right level (Either can or cannot change settings with remote software) 

Advanced security mode 

- 20 definable user accounts** 

- Different access right between each user account (User account can only be 

applied to local OSD and remote software) 

- Password encryption in network transmission. 

- 6 concurrent users in advanced security mode. 

 

Advanced security mode -- User account 

18 normal user accounts and 2 special defined user accounts (‘ADMINISTRATOR’ 
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and ‘DEFAULT LOCAL USER’) in RX 

 

Account structure 

Type Description Remark 

General setting 

User name Login user name from remote 

software  

4-16 characters 

Case non-sensitive 

Unique between each account 

Account type LOCAL / REMOTE / BOTH Allow user to login from local 

OSD / remote software / both 

Access right Access right of the user account (Access right) 

Remote account type setting 

Remote 

password 

Login password from remote 

software 

4-10 characters 

Case non-sensitive 

Local account type setting 

Local password Login password from local OSD 

menu 

4-10 characters (ONLY numeric 

character available) 

Unique between each account 

Local time out Automatic log-out time period 

when keypad ideal 

Except in playback state 

 

Special defined accounts 

ADMINISTRATOR 

 

Type Default Remark 

User name ADMINISTRATOR FIXED 

Account type BOTH FIXED 

Access right ALL FIXED 

Remote password 000000 Available to 

change 

Local password 111111 Available to 

change 

Local time out No time out Available to 

change 

 

DEFAULT LOCAL USER** 
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Type Default Remark 

User name DEFAULT USER FIXED 

Account type LOCAL FIXED 

Access right NONE Available to 

change 

Remote password -- NIL -- FIXED 

Local password -- NIL -- FIXED 

Local time out No time out FIXED 

 

** This is a local default user account. Local OSD will be login as this account 

automatically at RX startup, or when user logout in local OSD. 

 

Advanced security mode -- Access right 

 

Group Features Involved 

 

VIDEO MONITORING# Basic video monitoring with fixed cameras 

Browsing the event status** 

AUDIO MONITORING 

and PA 

Audio monitoring** 

P.A. with microphone, P.A. with pre-recorded voice clips 

PLAYBACK Video playback** 

Browsing event logs , connection log, setting log and operation 

log 

CAMERA CONTROL PTZ** 

EVENT CTRL Clear event 

SWITCH CONTROL Switch control 

{All video monitoring}, {audio monitoring} & {playback} access right group will be enabled 

VIDEO BACKUP Video extraction and backup 

RECORDING Start/stop recording 

Start/stop schedule recording 

SYSTEM SETTING Video format, camera installation, throughput control setting 

Change live video quality, brightness, contrast 

Network and modem setting 

Data/time setting 

Hard-disk formatting 

Recording setting 

Switch setting 
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Event setting  

Firmware upgrade 

Shutdown/restart 

Setting import/export 

All access right group will be enabled 

USER ACCOUNT User account setting 

Switch transmitter security mode 

Restore factory setting 

 

# At least one camera must be selected 

** Video monitoring dependence. For example, if a user does not has access right on 

camera 2 monitoring, he/she will not be able to browse event status, control PTZ and 

playback on this camera. 

  

25.5. Shortcut Keys 

Key Action 

Esc To change all the full screen windows to main windows 

(Restore windows) 

F5 Go to live view 

F6 Go to playback view 

F10 To change the live video to full screen windows 

 

 


